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Visual 1: Lesson 1: Introductions and 

Overview 
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Visual 2: Let's Get Acquainted! 

Participant introductions 

 Name 

 Organization  

 Role in organization  

 GIS and hazard analysis experience  

 Goals and expectations for this class  

Instructor introduction 
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Visual 3: Course Agenda 

 Day One: Introduction and Overview, Review of Disaster Operations, Basic 
Hurricane, Hurricane Response, and Hurricane Recovery  

 Day Two: CDMS, Site-Specific Data/UDF, Basic Flood, and Flood Response  

 Day Three: Flood Recovery, Basic Earthquake, Earthquake Response, and 
Earthquake Recovery  

 Day Four: Basic Tsunami, Tsunami Response and Recovery, Earthquake and 
Tsunami Combined Analysis, Hazus Products and Communication, and Course 
Wrap-up  
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Visual 4: Course Prerequisites 

 Completed the ArcGIS for Emergency Managers course and Basic Hazus 

 General understanding of GIS capabilities and the goals of disaster operations.  

 Recommended:  

 E0170: Hazus for Hurricane 

 E0172: Hazus for Flood 

 E0174: Hazus for Earthquake & Tsunami 

 E0317: Comprehensive Data Management System for Hazus  
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Course Prerequisites 

 Completed the ArcGIS for Emergency Managers course and Basic 
Hazus.  

 General understanding of GIS capabilities and the goals of 
disaster operations.  

 Recommended:  

 E0172: Hazus Flood or E0174: Hazus Earthquake or  

 E0170: Hazus Hurricane  

 E0317: Comprehensive Data Management System for Hazus  

 Participants should have a general understanding of GIS 
capabilities and the goals of disaster operations.  

 Information from National Preparedness Course Catalog Website. 
(https://www.firstrespondertraining.gov/frt/npccatalog/EMI#anc-
search-results)   

 

http://www.firstrespondertraining.gov/frt/npccatalog/EMI#anc-search-results
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Visual 5: Hints for Success 

Ask LOTS of questions! There are NO "silly" questions. 

Share your experiences with the rest of the class - they will learn from you and you from 
them. 

Try to apply the concepts presented in class to your own needs. If you don't see 
applicability, ask for an example. 

Practice the skills that you learn in class right away. 

 In class (exercises and "experiments") 

 After class (use it or lose it) 
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Visual 6: Course Tasks 

 Lecture  

 Discussion  

 Demonstration: Instructor-Led  

 Students observe instructor completing task  

 Activity: Instructor-Led  

 Guided Practice  

 Students follow along and complete task with instructor 

 Exercise: Student-Led  

 Individual or Small Group Practice  

 Hands-on  

 Shows how to apply material from this course to an actual incident 
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Visual 7: Lesson 1: Goal and Objectives 

Goal: To provide an overview of Hazus.  

 After completing this lesson you will be able to:  

 Summarize the purpose of Hazus.  

 List the hazards supported by Hazus.  

 Describe how Hazus supports emergency management.  

 Explain how data is integrated into Hazus.  
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Visual 8: What is Hazus? 

 Software tools and support system designed by FEMA for the purpose of providing 
communities with the means to identify and reduce risk from natural hazards 

 Used by a variety of communities and organizations  

 Available from FEMA free of charge (requires ArcGIS license with Spatial Analyst 
extension) 
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Visual 9: Supported Hazards 
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Visual 10: History 
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Visual 11: User Levels 
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Visual 12: Supporting Emergency Management 

 Identify vulnerable areas 

 Estimate potential impacts of hazards 

 Assess level of readiness and preparedness  

 Inform resource allocation  

 Prioritize mitigation measures 

 Inform response and post-disaster recovery efforts  
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Visual 13: Loss Estimation Process 

 Produce maps, tables, and reports 

 Analyze social and economic impacts 

 Consider what is at risk 

 Identify hazard  

 Identify physical landscape  

 

 

Direct Damages 
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Visual 14: Inventory (Exposure) 

General building types and occupancies  

 Lifelines  

 Replacement costs 

 Demographics 

Hazard-specific 

 Specific building types 

 First floor elevations 

 Building configurations  
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Visual 15: Integrating User-Provided Data 

Non-Hazard Data Integration Tools 

 Comprehensive Data Management System (CDMS) enables integration of locally 
developed non-hazard data 

 CDMS validates that user data are compliant with Hazus requirements 

Hazard Data Integration 

 ShakeMap and Hurrevac hazard data integration 

 Each model includes tools for integrating user-provided hazard data 

Techniques for integrating user-provided data are covered in other courses 
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Visual 16: Hazus 4.2 Capabilities 

Hazus 4.2 
Capabilities: 
Inputs 

Earthquake Flood Hurricane Tsunami 

 Ground 
Shaking  

 Ground 
Failure  

Frequency | 
Depth 

Riverine | 
Coastal 
Surge 

Wind 

Surge 

Depth | 
Momentum 

Flux  

 Runup | 
Velocity  

 Historic     

 Deterministic     

 Probabilistic     

 User-supplied     

 Other supported 
inputs 

Real-time & 
scenario 
USGS 

ShakeMaps 

Risk MAP,  
User-supplied 

depth grids 
(ArcGRID, 
GeoTIFF, 

IMAGINE), 
HEC-RAS 

(.FLT) 

Hurrevac, 
User-supplied 

wind files 
(.dat) 

NOAA PMEL 
SIFT, State 

models 
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Visual 17: Hardware and Software 

Requirements 

 Memory: 4 GB or higher  

 Disk space: 10GB for one multi-hazard large urban study region, plus inventory data 
size (varies by state), or 70 GB to store entire U.S. inventory data  

 Graphics Adaptor: 24-bit capable video card with at least 128 MB of video memory, 
resolution of 1078 x 768 or higher  

 Operating Systems: 64-bit versions of Windows 10 Professional and Enterprise, 
Windows 8.1, and Windows 7 Professional 

 Supporting Software: Appropriate version of Esri ArcGIS and the Spatial Analyst 
extension for the flood model  
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Visual 18: FEMA Hazus Website 

 

Primary FEMA resource for updated information related to Hazus: 
FEMA Hazus Website (www.fema.gov/hazus)  

 

 

 

http://www.fema.gov/hazus
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Visual 19: Installation 

 Log in with a full Administrator account 

 Download Hazus from the Map Service Center’s website. 
(msc.fema.gov/portal/resources/hazus) 

 Unzip the downloaded file 

 Right-click on setup.exe file and select “Run as Administrator” option  

 “Administrator Rights” can vary - consult the “Getting Started.pdf” document to 
ensure a proper installation 

 

http://msc.fema.gov/portal/resources/hazus
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Visual 20: Study Region Location 

 All study regions will be created in the 
folder specified in this window 

 All data related to the Study Region will 
be stored in this location 

 Default location is C:\HazusData\Regions  
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Visual 21: State Inventory Data 

 Download Hazus provided data 
(aggregated by each state) at the FEMA 
Hazus Download 
site: msc.fema.gov/portal/resources/hazus  

 Each State dataset is wrapped into a .exe 
file 

 Extract state(s) files of interest to Data 
Path folder by double-clicking the .exe file 
and selecting the data path folder 

 C:\HazusData\Inventory  

 

 

 

http://msc.fema.gov/portal/resources/hazus
http://msc.fema.gov/portal/resources/hazus
http://msc.fema.gov/portal/resources/hazus
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Visual 22: What is a Study Region? 

The area for which you are conducting a loss estimation study. 

Can be defined by state, county, or census tract. Flood only or flood-tsunami regions 
can also be defined by census block, community, or watershed. 

Questions to consider: 

 What type of hazard(s) are you studying? 

 What area(s) is the hazard likely to impact? 

 Do you need to understand impacts outside your immediate jurisdiction? 

No damage is assessed outside the study region - even if it exists! 
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Visual 23: Study Region Size 

 Size limit of 10 GB per database for SQL Server 2014 Express  

 The success of a Hazus analysis will depend on the available system resources of 
the PC  

 Large flood (riverine or coastal) and combined flood/wind analyses require large 
amounts of system resources even for small geographic areas (e.g., a single county) 
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Visual 24: Study Region Options 

Hazus Startup Window  

 Create a new region  

 Open a region  

 Delete a region  

 Duplicate a region  

 Export/Backup a region  

 Import a region  
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Visual 25: Discussion 1.1: Capabilities of Hazus 

Question: What is the role of Hazus in modeling…  

 dam breaks?  

 levee breaks?  

 pluvial flooding?  

 category 5 hurricanes?  

 minimal tropical storms?  

 an 11.5 magnitude earthquake?  

 Group: 3-6 people  

 Time: 15 minutes  
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Discussion 1.1: Capabilities of Hazus 

Question: What is the role of Hazus in modeling…  

 dam breaks?  

 levee breaks?  

 pluvial flooding?  

 category 5 hurricanes?  

 minimal tropical storms?  

 an 11.5 magnitude earthquake?  

Time: 15 minutes 

 Discussion Steps:  

1. Listen to instructor’s directions.  

2. Ask questions if they need directions clarified.  

3. Discuss the questions with your group.  

4. Designate a group member to share your answers with the class.  
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Visual 26: Lesson 1: Review 

1. What is the purpose of Hazus?  
2. What are the four hazards supported by Hazus?  
3. How does Hazus support emergency management?  
4. How is data integrated into Hazus?  
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Visual 27: Capstone Exercise Preview 

Goal: Understand the role of Hazus in assisting GIS analysts in a tabletop exercise.*  

Planning:  

 Day 1 (briefly) 

 Day 4 morning  

 Presentation:  

 Day 4 afternoon  

  

*The exercise and your supporting materials will be presented to the leadership team.  
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Visual 28: Capstone Exercise Preview 

 There is no written final exam for this course  

 Participants will be evaluated based on:  

 Completeness of the final presentation  

 Use of the ideas learned in this class  
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Visual 29: Capstone Exercise Explanation 

 Scenario: Disaster Operations Response and Recovery agencies are enacting a 
tabletop exercise modeling their response to a natural disaster.  

 You, as Hazus experts will act as the GIS analysts using Hazus to support the 
tabletop exercise.  

 The type of tabletop exercise is up to you.  

 Create maps and other Hazus products to facilitate the exercise. 

 Each group will present while the remaining participants assume the role of the 
leadership team.  

 Present and explain the type of tabletop exercise you are supporting.  

 Present and explain the materials you produced and why you produced those 
specifically.  
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Visual 30: Capstone Exercise Explanation 

Presentation Guidelines:  

 Should be prepared using PowerPoint.  

 Include maps, tables, or other media you deem appropriate and helpful for 
conveying your message.  

 Information should be primarily derived from Hazus, but may be supplemented by 
other sources. 

 10-15 minutes in length; allowing 5 minutes for questions.  

Leadership Team Guidelines:  

 Class and instructor will assume the role of the leadership team. 

 Leadership team may ask questions related to the presentation.  
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Visual 31: Capstone Exercise Preparation 

Goals:  

 Divide into 4 groups  

 Start discussing roles, strategies, and the type of tabletop exercise you are 
supporting. 

Time: 20 minutes 
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Visual 32: Questions 
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Lesson 2: Review of Disaster Operations 
Management 
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Visual 1: Lesson 2: Review of Disaster 

Operations Management 
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Visual 2: Lesson 2: Goal and Objectives 

Goal: To review the field of disaster operations and provide an understanding of 
emergency management.  

 After completing this lesson you will be able to: 

 Describe the effects of disasters.  

 Summarize the emergency management cycle. 

 Explain incident management activities during the response phase and recovery 
phase.  
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Visual 3: Disaster Effects 

Disasters typically result in the following types of damage:  

 Physical 

 Social 

 Economic 

 Special concerns (environmental, historic properties, etc.) 

 What are some ideas of how Hazus can assist Emergency Management prior to and 
following a major disaster? 
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Visual 4: Disaster Effects: Physical Impacts 

 Damage to community infrastructure assets  

 Roads, bridges, utilities  

 Damage or destroyed community facilities  

 Hospitals, government offices, etc.  

 Damage or destroyed homes and contents  

 Damage or destroyed commercial buildings  

What types of information can Hazus provide decision-makers?  
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Visual 5: Disaster Effects: Social Impacts 

 Casualties  

 Shelter needs  

 Special Populations:  

 Elderly, disabled, children, transient populations, single parents  

 Cultural Effects:  

 Education, literacy, household size  

 Social Capital:  

 Public trust, social dependence, crime  

Why is this information critical for preparedness operations?  
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Visual 6: Disaster Effects: Economic Impacts 

 Business interruption or closure  

 Job losses  

 Loss of Public Revenues:  

 Utilities, taxes, etc.  

 Long-run growth of the local economy suffers  
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Visual 7: Disaster Effects: Special Concerns 

 Environmental impacts  

 Special Properties:  

 Historic places, coastal zone management, etc.  

 Insurance  

 Operational Considerations:  

 Evacuations, sheltering, private-public partnerships, etc.  
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Visual 8: Hazus Summary Reports 

 

 Various summary reports are available for viewing and printing in the Results menu 

 Reports vary for each hazard  

 Common summary report categories: inventory, building, losses, other 

 "Other" may include summary reports specific to the hazard, such as evacuation 
time for tsunami 
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Visual 9: Hazus Export Tool 

 Hazus export toolbox is downloaded with Hazus installation 

 Add Hazus export toolbox to Arc toolbox 

 Run the export script to create a new geodatabase for your study region 

 The tool exports results from the latest run in your study region  
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Visual 10: Principles of Emergency 

Management 

 Comprehensive: taking into account all hazards, all stakeholders, all impacts  

 Progressive: take preventative measures to build disaster-resistant communities  

 Risk Driven: use sound risk management principles  

 Integrated: ensure unity of effort among all levels of government  

 Collaborative: create and sustain trust among peers, build consensus  

 Coordinated: organize resources to achieve a common goal  

 Professional: knowledge-based, ethical, continuous improvement  
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Principles of Emergency Management 

 Comprehensive: taking into account all hazards, all stakeholders, 
all impacts  

 Progressive: take preventative measures to build disaster-resistant 
communities  

 Risk Driven: use sound risk management principles  

 Integrated: ensure unity of effort among all levels of government  

 Collaborative: create and sustain trust among peers, build 
consensus  

 Coordinated: organize resources to achieve a common goal  

 Professional: knowledge-based, ethical, continuous improvement  

 Information from the Emergency Management Institute website: 
http://training.fema.gov/EMIWeb/edu/emprinciples.asp 

 

http://training.fema.gov/EMIWeb/edu/emprinciples.asp
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Visual 11: Disaster Declaration Process 

Types of Disaster Declarations 

 Declared Emergencies  

 Declared Major Disasters  
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Visual 12: Post-Earthquake Applications - PDA 

Hazus was deployed to support response to the M7.0 Alaskan Earthquake that struck 
near Anchorage on November 30, 2018. 

Hazus analysis was incorporated into Alaskan Governor Dunleavy’s Official Request to 
the White House for a Presidential Disaster Declaration. 

FEMA IA leadership confirmed: “Hazus estimates of building damage for the event 
(Hazus = Destroyed 5; Major 250) are a reasonable estimate of what is being found in 
the Preliminary Damage Assessments (PDA = 46 destroyed, 643 major) submitted by 
the State.” 
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Visual 13: Incident Management Actions: 

Phases of Emergency Management 
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Incident Management Actions: Phases of Emergency 
Management 

 Preparedness: Pre-Incident, Incident, Post-Incident  

 Prevention: Pre-Incident, Incident, Post-Incident  

 Response: Pre-Incident, Incident  

 Recovery: Incident, Post-Incident  

 Mitigation: Pre-Incident, Incident, Post-Incident    
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Visual 14: Preparedness 

 Preparing to handle an emergency  

 Includes plans or preparations made to save lives and to help response and rescue 
operations 

 Evacuation plans and stocking food and water are both examples of preparedness 

 Preparedness activities take place before, during, and after an emergency occurs 

 Hazus results can be used to help create community plans in case of future 
disasters  

 Results may support creation of injects for exercises 
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Visual 15: Response 

 Responding safely to an emergency and putting your preparedness plans into 
action.  

 Includes actions taken to save lives and prevent further property damage in an 
emergency situation.  

 Response activities take place pre-incident and during an emergency.  

 Includes incident management  

 Seeking shelter from a tornado or turning off gas valves in an earthquake are both 
response activities.   
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Visual 16: Recovery 

 Responding safely to an emergency 

 Includes actions taken to return to a normal or an even safer situation following an 
emergency or disaster.  

 Recovery includes getting financial assistance to help pay for the repairs.  

 Recovery activities can begin during an incident and continue to take place after an 
emergency.  
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Visual 17: Mitigation 

 The effort to reduce loss of life and property by lessening the impact of disasters.  

 Achieved through risk analysis, which provides the foundation for mitigation activities 
that reduce risk.  

 Hazus provides opportunity for detailed risk assessment useful for mitigation 
applications.  

Hazard Mitigation Grant Program (HMGP):  

 Provides grants to states/local governments to implement long-term hazard 
mitigation measures after a Major Disaster Declaration.  

 Enacts mitigation measures that reduce the risk of loss of life and property from 
future disasters.  
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Visual 18: Data Sources for Response Modeling 

 National, state, and local agencies  

 Floodplain boundary, Critical Infrastructure and Key Resources (CIKR), and 
community infrastructure 

 United States Geological Survey (USGS)  

 User supplied data maps for liquefaction, landslide, water depth, ShakeMap, and 
PAGER 

 National Hurricane Center (NHC)  

 Historical hurricane tracks, windspeeds, projected tracts 

 Pacific Marine Environmental Laboratory (PMEL)  

 Tsunami wave heights, inundation and depths, and momentum flux 

 FEMA Flood Map Service Center (MSC)  

 Depth grid, DFIRM 

 Provide your own data 

 Depth grid, user-defined facilities 
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Visual 19: Activity 2.1: Data Availability 

Goal: Explore the data available through the United States Geological Survey (USGS), 
the National Hurricane Center (NHC), the Pacific Marine Environmental Laboratory 
(PMEL), and the Map Service Center (MSC).   

 Time: 10 minutes  
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Activity 2.1: Data Availability 

Goal: Explore the data available through the United States Geological 
Survey (USGS), the National Hurricane Center (NHC), the Pacific 
Marine Environmental Laboratory (PMEL), and the Map Service 
Center (MSC).   

 Time: 10 minutes  

Activity Steps: 

1. Refer to Activities Document “02.1_Activity_Data Availability.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Follow along to complete the task with the instructor.  

5. Complete the goal assigned.  

6. Ask any final questions.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 2: Review of Disaster Operations Management  SM-56 

Visual 20: Demonstration 2.2: ArcGIS Online 

Goal: Review ArcGIS Online and other online platforms.  

 Time: 5 minutes  
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Demonstration 2.2: ArcGIS Online 

Goal: Review ArcGIS Online and other online platforms.  

 Time: 5 minutes  

Activity Steps:  

1. Refer to Activities Document “02.2_Demonstration_ArcGIS 
Online.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Watch the instructor's demonstration.  

5. Ask any final questions.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 2: Review of Disaster Operations Management  SM-57 

Visual 21: National Flood Hazard Layer 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 2: Review of Disaster Operations Management  SM-58 

Visual 22: Lesson 2: Review 

1. What are some examples of disasters that occur?  
2. What are the four typical effects of damage that result from disasters?  
3. Explain the emergency management cycle.  
4. What are examples of incident management activities during the response phase? 

The recovery phase?  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 2: Review of Disaster Operations Management  SM-59 

Visual 23: Questions 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-60 

Lesson 3: Basic Hurricane 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-61 

Visual 1: Lesson 3: Basic Hurricane 

  

  

  

  

  

  

  

  

  

  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-62 

Visual 2: Lesson 3: Goal and Objectives 

Goal: To provide a review of the hurricane wind and storm surge model within Hazus. 

 After completing this lesson you will be able to:  

 Review conditions for hurricane development and the parts of a hurricane.  

 Describe the areas of the U.S. mainland that have the highest risk to major 
hurricanes.  

 Provide four scenario types that a user can select to run the hurricane model.  

 List databases used in the hurricane model.  

 Explain damage and loss modeling.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-63 

Visual 3: Hurricane Basics 

 Rotate counter-clockwise in the Northern Hemisphere  

 Require ocean temperatures around 80° F or 27° C  

 Occurs between 5°N and 40°N in the Atlantic Ocean  

 Hurricane season: June 1 through November 30  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-64 

Visual 4: Converted Wind Speeds 

Typical Storm Parameters 

Hazus Input Wind Speeds = 1 Min Mean 

Hazus Output Wind Speeds = 3 Sec Gust 

Saffir-Simpson 
Scale 

1 Min Mean (mph) 3 Sec Gust (mph) Min Central 
Pressure (mb) 

1 74-95 90-116 980 and up 

2 96-110 117-134 965-979 

3 111-129 135-159 945-964 

4 130-156 160-189 921-944 

5 157+ 189+ 920 and below 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-65 

Visual 5: Hurricane Geography 

Hurricanes impact the US often follow one of two general paths 

 Staying in the Atlantic and tracking up the East Coast 

 Tracking the West Coast of Florida and entering the Gulf of Mexico 

Major hurricane U.S. strikes: 

 Florida has the greatest number 

 North Carolina, Louisiana, Mississippi, Alabama, and Texas are also high frequency 
areas 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-66 

Visual 6: Hurricane Impacts 

 Hurricane risks and impacts are dependent on the geography 

 Different states and regions will have different needs for response, recovery, and 
mitigation 

 The three storms in 2017 affected diverse geographic areas of varying size and 
population density 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-67 

Visual 7: Hurricane Anatomy 

1. Rain bands 
2. Eye 
3. Eye wall* 
4. Counterclockwise rotation 

 

 

*NOTE: A second outer eye wall may 
develop, but it can be difficult to differentiate 

from the inner eye wall. 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-68 

Visual 8: Hurricane Wind Hazard Model: Wind 

Field 

Wind Field Model:  

 Updated version of model used for design 
windspeeds in ASCE-7-98  

 Used in International Building Code 
Series 

 Allows for asymmetries (or unevenly 
distributed windfields) 

 

Asymmetric Katrina (2005).  Cooperative 
Institute for Meteorological Studies (CIMSS).  
University of Wisconsin. 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-69 

Visual 9: Hurricane Wind Model Scenarios 

Probabilistic wind speed database: 

 100,000 years of simulated storms 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-70 

Visual 10: Hurricane Wind Model Scenarios 

Deterministic: 

 Historical  

 Forecast/Advisory  

 User-defined  

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-71 

Visual 11: Wind Field Model 

 

Solves full non-linear equations of motion for translating hurricane; then establishes 
parameters for fast running simulation 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-72 

Visual 12: Hurricane Wind and Surge Analysis 

Options 

 Wind: losses created first in hurricane model 

 Surge: depths are input into the flood model 

 Combined flood and wind losses: sub-assembly loss tables 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-73 

Visual 13: Hurricane-Specific Inventory 

4 regions in Florida and 4 Regions in Hawaii 
have Hurricane-Specific Inventory and 4 
regions for other states  

Based on:  

 Review of building codes  

 Census data  

 Aerial photos review  

 MLS and tax data samples  

Florida/Hawaii building stock regions:  

 Different building codes  

 Different building practices  

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-74 

Visual 14: Hurricane Inventory 

 Terrain Database: surface roughness  

 State-Specific:  

 Land-Use: Florida Water Management District  

 Elevation: Hawaii Statewide GIS Program  

 Historic and Deterministic Storm Models:  

 HURDAT or Historic Database  

 Hurrevac  

 Tree Database: types, height, density  

 Hurricane Surge Model: flood depth damage curves  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-75 

Visual 15: Damage and Loss Modeling 

Damage includes effects of: 

 Wind pressures 

 Wind-borne debris 

 Tree blow-down 

 Rainfall 

 Storm duration 

Models damage explicitly to: 

 Roof cover 

 Roof deck 

 Whole roof failures 

 Window and door failures 

 Wall damage 

 

Jacksonville, FL, December 5, 2017 Pockets of debris from Hurricane Irma can still be 
seen all over the state. Counties are working hard to remove all hurricane related debris 
as quickly as possible. 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-76 

Visual 16: Damage and Loss Modeling 

Loss model based on:  

 Insurance loss data  

 Correlation of financial damage with 
observed water infiltration and building 
damage  

Current model now includes storm surge:  

 Hurricane and flooding analysis is coupled 

 

Debris from Hurricane Irma in Marathon, 
Florida has been scheduled for removal to 
clear waterway in this canal, which is surrounded by a full time commercial trailer park. 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-77 

Visual 17: Exercise 3.1: Hurricane Study Region 

Goal: Build a hurricane study region for Hurricane Harvey (2017).  

 Time: 10 minutes  
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Exercise 3.1: Hurricane Study Region 

Goal: Build a hurricane study region for Hurricane Harvey (2017).  

 Time: 10 minutes  

Exercise Steps: 

1. Refer to Activities Document “03.1_Exercise_Hurricane Study 
Region.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed. 

6. Complete the assigned goal.  

7. Be prepared to share your answers/results.  

8. Ask any final questions.  

  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-78 

Visual 18: Exercise 3.1: Tasks 

Task 1: Create a New Hurricane Study Region.  

Task 2: Select Areas Affected (Aransas County) by Hurricane Harvey.  
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Exercise 3.1: Tasks 

Refer to Activities Document “03.1_Exercise_Hurricane Study 
Region.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-79 

Visual 19: Lesson 3: Review 

1. Explain hurricane basics (components needed for development and four parts of a 
hurricane).  

2. What areas of the U.S. mainland have the highest risk to major hurricanes?  
3. Which four scenario types can a user select to run the hurricane model?  
4. Which databases are used in the hurricane model?  
5. Explain damage and loss modeling.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 3: Basic Hurricane  SM-80 

Visual 20: Questions 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-81 

Lesson 4: Hazus Hurricane for 
Response 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-82 

Visual 1: Lesson 4: Hazus Hurricane for 

Response 

  

  

  

  

  

  

  

  

  

  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-83 

Visual 2: Lesson 4: Goal and Objectives 

Goal: To understand how Hazus can aid situational awareness and generate useful 
products during hurricane response.  

 After completing this lesson you will be able to:  

 Summarize situational awareness.  

 Identify when and when not to use Hazus for hurricanes.  

 Demonstrate how to run models with Hurrevac.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-84 

Visual 3: Hurricane Forecasting 
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Hurricane Response Timeline and Coordination 

 NOAA uses a variety of tools to track and predict hurricane paths 
and possible landfall locations  

 These tools:  

 Include some level of uncertainty associated with the 
predictions  

 Uncertainty is realized through errors  

 Track errors have been reducing over time as technology and 
methodologies have improved.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-85 

Visual 4: When to Start Running Hazus 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-86 

Visual 5: Situational Awareness 

Hazus results can identify:  

 Areas of high losses 

 Shelter needs and displaced populations 

 Impacts to Critical Infrastructure and Key Resources (CIKR) 

 Power grids and water filtration plants 

 National monuments and government facilities 

 Telecommunications and transportation systems 

 Chemical facilities 

 Where disproportionate losses may occur 

 Vulnerable populations 

 Urban and rural areas 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-87 

Visual 6: Applications of Hazus for Hurricanes 

 Forecasting hurricane impacts on communities with Hurrevac data  

 Creating models of hurricanes with HURDAT data to explore scenarios around 
historical storms  

 Assess the combined losses of wind and storm surge  

 Modeling impacts on trees, debris, sheltering, and economic loss in hurricane 
forecast  

 Estimating losses from previous events 

 Not for long-term projections of hurricane size or track  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-88 

Visual 7: Hurricane Data Sources: Hurrevac 

 HURRicane EVACuation  

 Taken from National Hurricane Center advisory information  

 Useful for pre-event estimations 

 Post-event, use Hurrevac until observed wind fields are available 

 Great for creating hurricane exercise track information  

 If interested, consider taking E0170: Hazus for Hurricanes 

 Recent hurricane files (.stm) ship with Hazus and all are available 
via Hurrevac download button  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-89 

Visual 8: Hurrevac Import 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-90 

Visual 9: Hurrevac Import 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-91 

Visual 10: Exercise 4.1: Harvey Hurrevac Model 

 Goals:  

 Run Model with Hurrevac. 

 Develop a map of your choice: winds (by category), displaced population, economic 
loss, or tree debris.  

 View results.  

 Choose the same study region you created in Exercise 3.1.  

 Time: 45 minutes  
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Exercise 4.1: Harvey Hurrevac Model 

Goals:  

 Run Model with Hurrevac.  

 Develop a map of your choice: winds (by category), displaced 
population, economic loss, or tree debris.  

 View results.  

 Choose the same study region you created in Exercise 3.1.  

 Time: 45 minutes  

Exercise Steps: 

1. Refer to Activities Document “04.1_Exercise_Harvey Hurrevac 
Model.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed. 

6. Complete the assigned goal.  

7. Be prepared to share your answers/results.  

8. Ask any final questions.  

  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-92 

Visual 11: Exercise 4.1: Tasks 

Task 1: Open the Study Region.  

 Task 2: Create a New Scenario.  

 Task 3: Run the Analysis.  

 Task 4: View and Record the Results.  
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Exercise 4.1: Tasks 

Refer to Activities Document “04.1_Exercise_Harvey Hurrevac 
Model.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-93 

Visual 12: Discussion 4.2: Hurricane Harvey 

Questions:  

 Did you choose to make a map of winds (by category), displaced population, 
economic loss, or tree debris?  

 How is your map applicable to response leadership?  

 What platforms exist to share this data?  

 Time: 15 minutes  
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Discussion 4.2: Hurricane Harvey 

Questions:  

 Did you choose to make a map of winds (by category), displaced 
population, economic loss, or tree debris?  

 How is your map applicable to response leadership?  

 What platforms exist to share this data?  

 Time: 15 minutes  

 Discussion Steps:  

1. Listen to instructor’s directions.  

2. Ask questions if they need directions clarified. 

3. Answer the following questions and present your map to the class.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-94 

Visual 13: Dynamic Hurrevac Link 

 

 Hazus is dynamically linked to Hurrevac FTP site to provide real-time data 
availability 

 Advisories are available in Hazus as they become available in Hurrevac 

 Searching for the year and first letter of the storm's name will provide download 
options 

 Continuous update of advisories is crucial during response phase 

  

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-95 

Visual 14: Standard Products 

 Maps of wind hazards by category 

 Hazus summary reports: inventory, damage, loss  

 General Building Stock (GBS) damages and losses  

 Essential facilities damages and losses  

 Building and tree debris  

 Social losses, including displacements and shelter requirements  

 Identification of the locations of:  

 Critical Infrastructure and Key Resources (CIKR) 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-96 

Visual 15: Products During Response 

 Communicate products during response through daily video-teleconference with 
leadership across departments and agencies  

 Pre-landfall:  

 Shelter needs and points of distribution planning  

 Debris: trees, brick and wood, concrete and steel 

 Evacuation planning and transportation needs  

 Landfall: Disaster declarations  

 Allocate assets: storm surge and rapid deployment gauges, which support water-
level measurements  

 Hurricane Model Outputs: debris, damage probabilities, high potential loss 
facilities, etc.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-97 

Visual 16: Lesson 4: Review 

1. Summarize situational awareness.  
2. When should Hazus for Hurricanes be used? When should it not be used?  
3. How does Hurrevac work with Hazus?  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 4: Hazus Hurricane for Response  SM-98 

Visual 17: Questions 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-99 

Lesson 5: Hazus Hurricane for Recovery 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-100 

Visual 1: Lesson 5: Hazus Hurricane for 

Recovery 

  

  

  

  

  

  

  

  

  

  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-101 

Visual 2: Lesson 5: Goal and Objectives 

Goal: To understand the use of Hazus and FEMA assistance in hurricane recovery.  

 After completing this lesson you will be able to:  

 Understand the recovery timeline for hurricanes.  

 Explain the components of the FEMA Public Assistance Program.  

 Differentiate between Hurricane Wind and Surge Analysis option and Wind Field 
Model. 

 Utilize Hazus for response and recovery for pre and post hurricane.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-102 

Visual 3: Hurricane Recovery Timeline 

Length of recovery operations: 

 Days (Short-term): Resource Allocation  

 Weeks/Months (Intermediate): Clean up operations and local, state, & federal 
agency coordination 

 Months/Years (Long-term): Rebuilding  

 Recovery groups: Economic, Health and Social Services, Housing, Natural and 
Cultural Resources  

  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-103 

Visual 4: FEMA Public Assistance Program 

 FEMA's PA Program provides assistance to:  

 Local, State, Tribal, and Private Non-Profit 

 Communities can quickly respond to and recover from major disasters or 
emergencies declared by the president 

 What assistance can be received under the PA Program?  

 Emergency Work (Debris removal, Emergency Protective Measures)  

 Permanent Work (Restoration of disaster-damage permanent work to pre-
disaster conditions) 

 406 mitigation 

 What costs are eligible? 

 Labor, equipment, materials, contracts, administrative 

 How can Hazus support the program? 

 Informing hazard mitigation proposals or plans 

 Evaluating damages and recovery capabilities 

 Supporting project formulation 

FEMA Public Assistance Program Website: https://www.fema.gov/hazard-mitigation-
grant-program  

 

http://www.fema.gov/hazard-mitigation-grant-program


March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-104 

Visual 5: FEMA Mitigation Grant Program 

 Section 406 (presidential declared affected areas) 

 Up to 75/25 cost coverage with work completed within 12 months 

 Must be in a "declared disaster" county 

 Template for requesting assistance through FEMA 

1. Identify potential or actual impact areas  
2. Complete an Eligibility Analysis of any related damages  
3. Develop scope and costs of improvements/repairs 
4. Obligate damages for funding  

To learn more about FEMA’s PA Program, please visit: https://www.fema.gov/public-
assistance-local-state-tribal-and-non-profit  

 

http://www.fema.gov/public-assistance-local-state-tribal-and-non-profit


March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-105 

Visual 6: Hurricane Data in Hazus 

 Some historic hurricane data is included with Hazus  

 Hurrevac track data pre-loaded through 2017 storms 

 Only historical storms that affected the study region created can be selected as a 
scenario 

 Information includes: 

 Year 

 Name 

 Peak gust 

 States affected 

 Landfall states 

  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-106 

Visual 7: Hurricane Data (Hurdat) Sources 

 Hurdat is modeled for historic data 

 National Hurricane Center: https://www.nhc.noaa.gov/data/#hurdat  

 HURDAT2: Best Track Data  

 Atlantic and Pacific  

 Comma-delimited, text format  

 Six-hourly information on location, maximum winds, central pressure, and size of all 
known tropical and subtropical cyclones  

  

 

http://www.nhc.noaa.gov/data/#hurdat 


March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-107 

Visual 8: Hurricane Data (.dat) Sources 

 A census tract file that has observed maximum sustained winds and peak wind 
gusts tied to census tract centroids 

 A method to bring maximum windspeeds based upon observations into Hazus 

 .dat files must already be available and created using the format established 
originally by the NOAA Atlantic Oceanographic and Meteorological Laboratory 
(AOML) Hurricane Research Division (HDR) for their retired H*wind Program 

 These are generally available within a few days after the storm makes landfall for all 
major hurricanes 

 They are often updated over time as more observations come and are finalized 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-108 

Visual 9: Exercise 5.1: Harvey .dat Model  

 Goals:  

 Run Model with .dat data.  

 Develop a map of your choice: winds (by category), displaced population, economic 
loss, or tree debris.  

 View Results.  

 Choose the same study region you created in Exercise 3.1 and topic in Exercise 4.1.  

 Time: 45 minutes  
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Exercise 5.1: Harvey .dat Model  

Goals:  

 Run Model with .dat data.  

 Develop a map of your choice: winds (by category), displaced 
population, economic loss, or tree debris.  

 View Results. 

 Choose the same study region you created in Exercise 3.1 and 
topic you chose in Exercise 4.1. 

 Time: 45 minutes  

Exercise Steps: 

1. Refer to Activities Document “05.1_Exercise_Harvey (.dat) Model.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed. 

6. Complete the assigned goal.  

7. Be prepared to share your answers/results.  

8. Ask any final questions.  

  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-109 

Visual 10: Exercise 5.1: Tasks 

Task 1: Open the Study Region.  

 Task 2: Create a New Scenario.  

 Task 3: Run the Analysis.  

 Task 4: View and Record the Results.  
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Exercise 5.1: Tasks 

Refer to Activities Document “05.1_Exercise_Harvey (.dat) Model.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-110 

Visual 11: Exercise 5.2: Compare the Outputs 

 Goal: Compare the Hurrevac and .dat results for Hurricane Harvey.  

 Time: 15 minutes  
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Exercise 5.2: Compare the Outputs 

Goal: Compare the Hurrevac and .dat results for Hurricane Harvey.  

 Time: 15 minutes  

Exercise Steps: 

1. Refer to Activities Document “05.2_Exercise_Compare the 
Outputs.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed. 

6. Complete the assigned goal.  

7. Be prepared to share your answers/results.  

8. Ask any final questions.  

  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-111 

Visual 12: Exercise 5.2: Tasks 

Task 1: View the Results from the Hurrevac Output (previous lesson). 

 Task 2: View the Results from the .dat Output (earlier this lesson).  

 Task 3: Compare the Results and Identify Differences.  
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Exercise 5.2: Tasks 

Refer to Activities Document “05.2_Exercise_Compare the Outputs.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-112 

Visual 13: Discussion 5.3: Hurricane Modeling 

Questions:  

 How do the results compare with one another?  

 How can this be used for Recovery and Mitigation?  

 How does Hazus Hurricane fit into the JFO cycle?  

 Time: 15 minutes  
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Discussion 5.3: Hurricane Modeling 

Questions:  

 How do the results compare with one another?  

 How can this be used for Recovery and Mitigation? 

 How does Hazus Hurricane fit into the JFO cycle?  

 Time: 15 minutes  

Discussion Steps: 

1.  Listen to instructor’s directions.  

2. Ask questions if they need directions clarified.  

3. Discuss the questions with your group.  

4. Designate a group member to share your answers with the class.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-113 

Visual 14: Hazus for Hurricane Review 

Pre-event applications of outputs:  

 Development of mitigation strategies that outline policies/programs for:  

 Reducing hurricane losses/disruptions indicated in initial loss estimation study  

 Strategies can involve upgrading existing buildings (e.g., shutters) and the 
adoption of new building codes  

 Anticipation of the nature and scope of response and recovery efforts including:  

 Identifying short-term shelter requirements  

 Debris management requirements  

 Evacuation Planning and Transportation needs 

 Preposition of assets for response  

For more information, consider taking E0170: Hazus for Hurricanes 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-114 

Visual 15: Hazus for Response and Recovery: 

Post-Event 

Post-event applications of the outputs:  

 Projection of immediate economic impact assessments including: 

 Supporting the declaration of a state and/or federal disaster  

 Calculating direct economic impact on public and private resources, local 
governments, and functionality of the area  

 Activation of immediate emergency recovery efforts including:  

 Providing emergency housing shelters  

 Initiating debris clean-up efforts 

 Initiating evacuation and transportation needs 

 Application of long-term reconstruction plans including:  

 Identifying long-term reconstruction goals 

 Instituting appropriate wide-range economic development plans for the entire 
area  

 Allocating permanent housing needs, and the application of land use planning 
principles and practices  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-115 

Visual 16: Lesson 5: Review 

1. Who is eligible for the FEMA Public Assistance Program?  
2. What assistance can be received under the Public Assistance Program?  
3. How is Hazus utilized pre-hurricane? Post-hurricane?  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 5: Hazus Hurricane for Recovery  SM-116 

Visual 17: Questions 
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Lesson 6: CDMS  SM-117 

Lesson 6: CDMS 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-118 

Visual 1: Lesson 6: Comprehensive Data 

Management System 

  

  

  

  

  

  

  

  

  

  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-119 

Visual 2: Lesson 6: Goal and Objectives 

Goal: To gain familiarity with use of CDMS to update and import/export data.  

 After completing this lesson you will be able to:  

 Explain CDMS.  

 Identify what data sources feed in and out of CDMS.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-120 

Visual 3: What is CDMS? 

 A system for integrating user-provided site-specific and aggregate data into the 
Hazus state databases.  

 CDMS supported data includes:  

 Site-specific  

 Aggregate  

 Building-specific  

 Functions:  

 Validates user-provided data  

 Parses data into appropriate Hazus tables  

 Provides historical tracking of database updates  

 Can import/export data to/from a variety of formats  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-121 

Visual 4: Comprehensive Data Management 

System 
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Comprehensive Data Management System 

Excel and Access 2003, Shapefile, Personal GDB > Repository > 
SQL Server  

 SQL Server = State Database or Study Region, Tables, Feature 
Classes  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-122 

Visual 5: CDMS Help File 

 A compiled CDMS Help File is provided.  

 Useful for reviewing concepts and 
definitions:  

 Getting Started Instructions  

 Searchable  

 Importing, Querying, and Exporting 
step-by-step instructions 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-123 

Visual 6: Default State Database 

 The first time CDMS runs, you must 
specify a default statewide database 
location on a local drive. 

 Be sure to verify that you have read/write 
access to the data. 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-124 

Visual 7: Querying Statewide Datasets 

CDMS allows you to query existing state data by State, County, Census Tract, or 
Census Block. 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-125 

Visual 8: Export Options 

 Delete one or more records; often a useful step prior to updating the inventory. 

 Export results to Excel or personal Geodatabase. 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-126 

Visual 9: Options for Updating GBS Inventory 

 Import user-supplied pre-aggregated data 

 Import user-supplied site-specific data 

 Import user-supplied building specific data 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-127 

Visual 10: Updating From Pre-Aggregated Data 

GBS tables can be updated from pre-
aggregated data: 

 Building counts by Census Block/Tract 

 Demographics by Census Block/Tract 

 Building area by Census Block/Tract 

 Building exposure value by Census 
Block/Tract 

 Content exposure value by Census 
Block/Tract 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-128 

Visual 11: Aggregation Process 

1. Select the source file to import. 
2. Specify the destination category and table 

to update. 
3. Specify the table to import. 
4. Field matching. Validation. 
5. View Results. 
6. Transfer to state database. 

 

 

NOTE: This option is ideal for users that 
already maintain data at an aggregate level.  
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Lesson 6: CDMS  SM-129 

Visual 12: Source to Destination Dataset 

Imported table must conform to the structure of the state database you are updating. 

1. Select aggregated data for category. 
2. Select an inventory dataset. 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-130 

Visual 13: Import Table or Worksheet 

 If the import is from a Shapefile, the import table is automatically selected. 

 If the import is an MS Access or MS Excel file, the user has to specify the table or 
worksheet that contains the data. 
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Lesson 6: CDMS  SM-131 

Visual 14: Field Matching 

 Fields with the same name/characteristics are auto-matched. 

 Other fields must be manually matched. 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-132 

Visual 15: Exercise 6.1: GBS Data 

Goal: Identify and export data from a state dataset.  

Time: 15 minutes  
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Exercise 6.1: GBS Data 

Goal: Identify and export data from a state dataset.  

 Time: 15 minutes  

Exercise Steps: 

1.  Refer to Activities Document “06.1_Exercise_GBS Data.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed.  

6. Complete the assigned goal.  

7. Be prepared to share your answers/results.  

8. Ask any final questions.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-133 

Visual 16: Exercise 6.1: Tasks 

Task 1: Open CDMS and change State Databases.  

 Task 2: Query County for Specific Buildings.  

 Task 3: Export Query to Excel.  
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Exercise 6.1: Tasks 

Refer to Activities Document “06.1_Exercise_GBS Data.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-134 

Visual 17: Site-Specific Update Process 

1. Select source data file and destination 
category. 

2. Define source data parameters. 
3. Match fields. 
4. Categorize data. 
5. Validation. 
6. Review results in CDMS repository. 
7. Transfer to state database.  

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-135 

Visual 18: Source Category and Dataset 

 File name and location, category and inventory dataset 

 

 

Note: Specify a hazard if you plan to modify or import hazard-specific information. 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-136 

Visual 19: Source Data Parameters 

Specifies: 

 Table containing data 

 Hazus-ID field 

 Coordinate fields (dependent on data 
type) 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-137 

Visual 20: Field Matching 

 Specifies how fields in the input table are 
related to fields in the Hazus inventory. 

 CDMS auto-matches fields with the same 
name and characteristics. 

 Colors indicate which fields are required 
or can have defaults auto-assigned.  

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-138 

Visual 21: Field Matching 

 

 

NOTE: Templates save on setup time in 
cases where you will be importing data on a 
recurring basis. 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-139 

Visual 22: Categorizing Data 

Category matching specifies how individual values in a field relate to Hazus required 
values. 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-140 

Visual 23: Validation 

 CDMS will identify situations where the data being imported does not match Hazus 
requirements. 

 The solution is to fix the data, and then attempt the import process again. 

 Familiarity with the Hazus data requirements is vital for troubleshooting validation 
errors.  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-141 

Visual 24: Exercise 6.2: Site-Specific Data 

Goal: Use CDMS to update existing inventory.  

 Time: 30 minutes  
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Exercise 6.2: Site-Specific Data 

Goal: Use CDMS to update existing inventory.  

 Time: 30 minutes  

Exercise Steps: 

1.  Refer to Activities Document “06.2_Exercise_Site-Specific Data.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed.  

6. Complete the assigned goal.  

7. Be prepared to share your answers/results.  

8. Ask any final questions.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-142 

Visual 25: Exercise 6.2: Tasks 

Task 1: Query Hospitals in Salt Lake and Delete Existing Inventory.  

 Task 2: Import Medical Facilities Data Set into CDMS.  

 Task 3: Match Source and Destination Fields.  

 Task 4: Update State Database and Query for Confirmation.  
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Exercise 6.2: Tasks 

Refer to Activities Document “06.2_Exercise_Site-Specific Data.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-143 

Visual 26: Lesson 6: Review 

1. What are the functions of CDMS?  
2. What data sources feed in and out of CDMS?  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 6: CDMS  SM-144 

Visual 27: Questions 
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Lesson 7: Site-Specific/UDF 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-146 

Visual 1: Lesson 7: Site-Specific Data and 

User-Defined Facilities 

  

  

  

  

  

  

  

  

  

  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-147 

Visual 2: Lesson 7: Goal and Objectives 

 Goal: To explore datasets that effectively support disaster operations.  

 After completing this lesson you will be able to:  

 Explain the differences between GBS and UDF.  

 Identify what data is required to complete an assessment.  

 Differentiate between the different hazard’s analysis data.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-148 

Visual 3: Difference Between GBS and UDF 

General Building Stock: an engineering based estimation of structures by occupancy  

 Aggregate data by Census geography according to hazard type  

 Reported by square footage, dollar exposure, building count  

 Linked during development, but not in software  

 User-Defined Facilities: building or structure specific data  

 Must be imported through CDMS by the user  

 Provides actual locations of buildings  

 Replacement value rather than appraisal value of buildings  

Site-Specific Data: building or structure specific data  

 Some data included in Hazus inventory, such as hospitals, fire stations, and schools 

 May include user-defined, AEBM, high potential loss, essential, transportation and 
utility facilities 

 Damages assessed on an individual building basis 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-149 

Visual 4: UDF Data 

 Produces results and loss estimates at the structure level  

 Can often help facilitate risk discussions with individual homeowners or business 
owners in a community  

 Provides valuable information to help pre-screen properties and projects before 
going through a more in-depth Benefit-Cost Analysis (BCA)  

 Generally the best and most accurate approach to analyzing and communicating risk  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-150 

Visual 5: Site-Specific Inventory 

 Provides “actual” locations of buildings rather than aggregated General Building 
Stock tables (site-specific GBS data are referred to as user-defined facilities)  

 Sources vary by inventory type:  

 Essential Facilities: medical, fire, police, schools, etc.  

 High Potential Loss Facilities: dams, nuclear, military  

 Transportation Systems: bridges, highways, rail, airports, etc.  

 Utility Systems: water, oil, gas, electric, etc.  

 Hazardous Material Sites  

 User-Defined Facility  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-151 

Visual 6: Hazard-Specific Data: Debris 

Analysis 

To complete an assessment of situation, the following data is needed:  

 Hazard areas of impact  

 Demographics (# of households/density/land use)  

 Vegetation coverage  

 Critical infrastructure/assets  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-152 

Visual 7: Assessor Data 

 Data can often be downloaded from county or city governments.  

 May be free or require payment  

 Will require pre-processing for import to Hazus  

 Converting assessor data to user-defined facilities:  

 Build appropriate study region  

 Create building footprint centroids feature class  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-153 

Visual 8: Demonstration 7.1: Tax Assessor 

Data 

Goal: Explore Tax Assessor Data.  

 Time: 10 minutes  
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Demonstration 7.1: Tax Assessor Data 

Goal: Explore Tax Assessor Data.  

 Time: 10 minutes  

  Demonstration Steps:    

1. Listen to instructor’s directions.  

2. Ask questions if clarification is needed.  

3. Watch the instructor’s demonstration.  

4. Ask any final questions.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-154 

Visual 9: Hazard-Specific Data: Hurricane 

Analysis 

 Trees: U.S. Forestry Service, LiDAR-derived tree locations, State Department of 
Natural Resources  

 Terrain: Land cover datasets obtained from State Departments of Natural 
Resources, USGS, or locally derived  

 Shelter: Red Cross National Shelter System, State Homeland Security and local 
shelter personnel. Examine a historic disaster and the sheltering demographics and 
adjust the parameters  

 Economic Loss: U.S. Dept. of Commerce’s Bureau of Economic Analysis  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-155 

Visual 10: Hazard-Specific Data: Flood Analysis 

 Debris Weight (no vegetative): R.S. Means  

 Shelter: State Homeland Security and local shelter personnel.  

 Economic Loss: U.S. Dept. of Commerce’s Bureau of Economic Analysis  

 Agriculture products: damage functions from the U.S. Army Corps of Engineers 

 Vehicles: count based on building occupancies in each census block 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-156 

Visual 11: Hazard-Specific Data: Earthquake 

Analysis 

 Debris Weight (no vegetative): R.S. Means  

 Shelter: State Homeland Security and local shelter personnel.  

 Economic Loss: U.S. Dept. of Commerce’s Bureau of Economic Analysis  

 Fire Following: Local fire departments, universities (geology and earthquake hazard 
research)  

 Transportation Economic Loss: Regional and local planning agencies  

 Utility Economic Loss: Utility companies (private and local)  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-157 

Visual 12: Hazard-Specific Data: Tsunami 

Analysis 

 General Building Stock: US Army Corps of Engineers National Structure (NSI) point 
data  

 Essential User-Defined Facilities  

 Casualty analysis: hazard boundary and fatality boundary  

 Pedestrian evacuation: travel and warning times  

 Community preparedness level (evacuation): FEMA rating of good, fair, or poor 

 Traffic factor (evacuation): travel speed and road networks 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-158 

Visual 13: Exercise 7.2: UDF Database 

Goal: Load UDF into Hazus through CDMS.  

 Time: 20 minutes   
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Exercise 7.2: UDF Database 

Goal: Load UDF into Hazus through CDMS.  

 Time: 20 minutes  

 Exercise Steps: 

1.  Refer to Activities Document “07.2_Exercise_UDF Database.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed.  

6. Complete the assigned goal.  

7. Be prepared to share your answers/results.  

8. Ask any final questions.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-159 

Visual 14: Exercise 7.2: Tasks 

Task 1: Open CDMS and confirm or change State Database.  

 Task 2: Import the UDF data with CDMS and set Import Parameters.  

 Task 3: Complete Data Field Mapping.  

 Task 4: View Table and Import into State Geodatabase.  
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Exercise 7.2: Tasks 

Refer to Activities Document “07.2_Exercise_UDF Database.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-160 

Visual 15: Lesson 7: Review 

1. What is the difference between GBS and UDF?  
2. What data is required to complete an assessment?  
3. Describe the different analysis data for the various hazards.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 7: Site-Specific/UDF  SM-161 

Visual 16: Questions 
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Lesson 8: Basic Flood 
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Lesson 8: Basic Flood  SM-163 

Visual 1: Lesson 8: Basic Flood 

  

  

  

  

  

  

  

  

  

  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 8: Basic Flood  SM-164 

Visual 2: Lesson 8: Goal and Objectives 

Goal: To provide a review of the flood model within Hazus.  

 After completing this lesson you will be able to:  

 List the inputs of Flood Hazard.  

 Describe the Depth Damage Functions (DDFs).  

 Identify the factors that influence flood damage to buildings.  

 Explain dasymetric inventory.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 8: Basic Flood  SM-165 

Visual 3: Flood Basics 

Flood Hazard Inputs: 

 User-Defined analysis options (Quick Look and Enhanced Quick Look)  

 User-Defined depth grid  

 Digital Flood Insurance Rate Map (DFIRM)  

 High Water Mark Data  

 HEC-RAS 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 8: Basic Flood  SM-166 

Visual 4: Flood-Specific Inventory 

Dasymetric Inventory:  

 Flood Model only 

 Assumes building exposure only exists 
within areas which satellite and land-use 
data confirm there exists a built 
environment  

 Based upon the 2011 National Land 
Cover Dataset (NLCD) 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 8: Basic Flood  SM-167 

Visual 5: Flood-Specific Inventory 

General Building Stock:  

 Depreciated Replacement Costs  

 Estimates depreciated value of structures (used for insurance 
purposes)  

 Distribution of foundation types and first-floor heights 

 Estimates the first floor height based upon the foundation type  

Models differ for riverine, coastal, and Great Lakes census blocks, 
as well as for Pre-FIRM and Post-FIRM structures 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 8: Basic Flood  SM-168 

Visual 6: Depth-Damage Functions 

 

Default depth-damage functions are assigned based on building characteristics 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 8: Basic Flood  SM-169 

Visual 7: Depth-Damage Functions (DDFs) 

 Assigned based on building characteristics  

 Factors influencing flood damage to buildings:  

 Water (most important)  

 Duration  

 Velocity  

 Salinity  

 Applied to relevant depth  

 Buildings: first-floor height  

 Equipment: Height above first floor  

 NOTE:  

 Low water depths: steep slopes  

 High water depths: flatter sections  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 8: Basic Flood  SM-170 

Visual 8: GBS Loss Estimation Methodology 

Hazus performs an area weighted assessment 
of damage for aggregate inventory  

 Number of grid cells at a given depth is 
counted and then divided by total number of 
cells within census block  

 Result is used to “weight” damage at that 
flood depth for each occupancy 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 8: Basic Flood  SM-171 

Visual 9: GBS Loss Estimation Methodology 

(Cont'd.) 

Assumes that inventory is evenly distributed 
across each census block.  

 Example: If 25% of the block has 2 ft. of 
water, it is assumed that 25% of the four 
single-family dwellings in the block are in 2 ft. 
of water.  

 Losses are reported as totals for each 
occupancy and building type rather than for 
each building.  

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 8: Basic Flood  SM-172 

Visual 10: Exercise 8.1: Depth Grid 

Goals: Import a 100-year depth grid. 

 Time: 25 minutes  
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Exercise 8.1: Depth Grid 

Goals: Import a 100-year depth grid.  

 Time: 25 minutes  

Exercise Steps: 

1. Refer to Activities Document “08.1_Exercise_Depth Grid.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed. 

6. Complete the assigned goal.  

7. Be prepared to share your answers/results.  

8. Ask any final questions.  

  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 8: Basic Flood  SM-173 

Visual 11: Exercise 8.1: Tasks 

Task 1: Create a new Salt Lake City Study Region.  

 Task 2: Open Salt Lake City Study Region.  

 Task 3: Use Hazus Interface to Define a DFIRM.  

 Task 4: View Results.     
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Exercise 8.1: Tasks 

Refer to Activities Document “08.1_Exercise_Depth Grid.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 8: Basic Flood  SM-174 

Visual 12: Lesson 8: Review 

1. What are the inputs of the Flood Hazard?  
2. What are the Depth Damage Functions (DDFs) based on?  
3. What factors influence flood damage to buildings?  
4. What is dasymetric inventory?  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 8: Basic Flood  SM-175 

Visual 13: Questions 
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Lesson 9: Hazus Flood for Response 
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Lesson 9: Hazus Flood for Response  SM-177 

Visual 1: Lesson 9: Hazus Flood for Response 

  

  

  

  

  

  

  

  

  

  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-178 

Visual 2: Lesson 9: Goal and Objectives 

Goal: To review the applications of Hazus in flood response.  

 After completing this lesson you will be able to:  

 Understand the flood response timeline.  

 Identify when and when not to use Hazus for flood.  

 Describe a flood depth grid.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-179 

Visual 3: Flood Response Timeline and 

Coordination 

Preparation for Flooding:  

 Identify jurisdiction’s susceptibility to floods  

 Estimating vulnerable zones  

 Flood fighting  

 NWS issues flood warnings  

 Once Flooding Occurs:  

 Search and Rescue  

 Continuity of Operations  

 Inspection and Condemnation  

  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-180 

Visual 4: When to Use Hazus for Floods 

Use Hazus to create:  

 Identify areas with differential impacts 

 Create user-defined scenarios 

 Utilize depth grids for damage and loss estimations 

  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-181 

Visual 5: When Not to Use Hazus for Floods 

 Regulated Streams:  

 Not computed in Hazus unless gage available  

 Must use user-defined hazard input 

 Hydrologic analysis is NOT necessary if you are providing results from another flood 
study, such as:  

 Entering discharges  

 Quick Look: drawing a polygon having a constant flood depth  

 Enhanced Quick Look: providing a flood plain boundary and DEM  

 Providing a flood depth grid  

 HEC-RAS input  

 Dam Failures - Hazus does not model dam failures 

 Creating the flood hazard or anything that is not loss estimation 

 Level 1 hydraulic and hydrologic modeling should not be used during response 

  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-182 

Visual 6: Hazus Flood Data Sources 

 National Oceanic and Atmospheric Administration (NOAA) 

 Federal Emergency Management Agency (FEMA)  

 Map Service Center (MSC)  

 Flood Insurance Studies 

 Risk MAP non-regulatory products 

 HEC-RAS (US Army Corps of Engineers)  

 National Elevation Dataset (US Geological Survey)  

 Bare earth digital elevation models (DEM)  

 Source lidar point clouds  

 Ifsar digital source models (DSM)  

 User-defined depth grids  

 Shapefiles, rasters, depth grids, and imagery from state and local governments  

  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-183 

Visual 7: Depth Grid 

 Raster surface with depth value for each 
pixel 

 Interpolates elevation between cross-
sections 

 Creates a flood elevation surface 

 Flood Depth Grid = Flood Surface – 
Ground Elevation  

 Sources may include digital flood 
insurance rate maps, high water mark 
data, and many are available for 
download from FEMA MSC  

 

Depth grid derived from DFIRM data for Denver, Colorado. Darker shaded areas 
designate deeper water. For example, the areas adjacent to the river stream. Lighter 
shaded areas designate shallow water. For example, urban street grids further away 
from river stream. 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-184 

Visual 8: Exercise 9.1: DFIRM Depth Grid 

Goals:  

 Create a depth grid based off the DFIRM dataset and the Esri ArcMap Spatial 
Analyst toolset.  

 Keep track of the name of the files generated.  

 Time: 30 minutes  
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Exercise 9.1: DFIRM Depth Grid 

Goals:  

 Create a depth grid based off the DFIRM dataset and the Esri 
ArcMap Spatial Analyst toolset.  

 Keep track of the name of the files generated.  

 Time: 30 minutes  

Exercise Steps: 

1. Refer to Activities Document “09.1_Exercise_DFIRM Depth Grid.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed. 

6. Complete the assigned goal.  

7. Be prepared to share your answers/results.  

8. Ask any final questions.  

  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-185 

Visual 9: Exercise 9.1: Tasks 

Task 1: Prepare the Data in ArcMap.  

 Task 2: Interpolate the Water Surface.  

 Task 3: Prepare the Depth Grid.  

 Task 4: Understand the DFIRM Database.  
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Exercise 9.1: Tasks 

Refer to Activities Document “09.1_Exercise_DFIRM Depth Grid.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-186 

Visual 10: Running the Analysis 

 User selects desired analysis lessons to 
run 

 Lessons can be re-run as needed 

 Hint: Select only the analysis you need 
(speeds up processing time) 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-187 

Visual 11: Viewing Depth-Damage Functions 

Instructor Demonstration  

 Open the Depth-Damage Functions viewer for buildings 

 Change default damage functions 

 View the library 

 Demonstrate creating a new damage function 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-188 

Visual 12: Agriculture Products 

User must input a calendar date (e.g., May 25 that is 
converted to Julian Calendar (1 to 365) to define relation to 
crop cycle. 

Damage is not flood-depth dependent. 

 Area of impacted crop is determined. 

No duration estimate is calculated. 

 Flood Model estimates flood damage if duration is 0 days, 
3 days, 7 days, or 14 days. 

Based on USACE's AGDAM method. 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-189 

Visual 13: Vehicles 

 Damages are based on type of vehicle and depth of water relative to critical vehicle 
components 

 Hazus developed damage functions are based on expert opinion and historical 
damage data 

Vehicl
eType 

Vehicl
eID 

Descri
ption 

Vehicl
eHeig
ht 

0 ft 0.5 ft 1 ft 1.5 ft 2 ft 2.5 ft 

Car Passe
nger 
Car 

Dama
ge to 
car 
from 
inunda
tion 
only 

1.5 0 7.5 15 20 40 60 

LtTrk Light 
Truck 

Dama
ge to 
light 
truck 
from 
inunda
tion 
only 

2.7 0 3 6 9 12 15 

HvTrk Heavy 
Truck 

Dama
ge to 
heavy 
truck 
from 
inunda
tion 
only 

7 0 1.9 3 5 7 8.3 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-190 

Visual 14: Flood Warning 

 Warning of imminent flooding can reduce 
damage up to 35% (The Day Curve) 

 Hazus will reduce losses by user-defined 
percentage 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-191 

Visual 15: Debris Parameters 

Debris analysis can be modified to account for  

 Occupancy and Foundation Type  

 Finish, Structure, and Foundation Weight  

Specific 
Occupanc

y 

Foundatio
n Type 

Minimum 
Depth 

Maximum 
Depth 

Finish 
Weight 

Per Thous 
Sq Ft 

Structure 
Weight 

Per Thous 
Sq Ft 

Foundatio
n Weight 

Per Thous 
Sq Ft 

RES1 Slab 0 4 4.1 0 0 

RES1 Slab 4 8 6.8 0 0 

RES1 Slab 8 25 6.8 6.5 25 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-192 

Visual 16: Shelter 

 

Parameters 

 Evacuation buffer 

 Income 

 Age 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-193 

Visual 17: Direct Economic Losses 

Parameters:  

 Annual Gross Sales  

 Restoration Time  

 Income and Wage Losses  

 Inventory Value 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-194 

Visual 18: Lesson 9: Review 

1. Summarize the flood response timeline.  
2. When should Hazus for Flood be used?  When should it not be used?  
3. What is a flood depth grid and how is it created?  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 9: Hazus Flood for Response  SM-195 

Visual 19: Questions 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 10: Hazus Flood for Recovery  SM-196 

Lesson 10: Hazus Flood for Recovery 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 10: Hazus Flood for Recovery  SM-197 

Visual 1: Lesson 10: Hazus Flood for Recovery 

  

  

  

  

  

  

  

  

  

  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 10: Hazus Flood for Recovery  SM-198 

Visual 2: Lesson 10: Goal and Objectives 

Goal: To review the applications of Hazus for flood recovery.  

 After completing this lesson you will be able to:  

 Explain the ways that FEMA provides help according to the Individual Assistance 
Program.  

 List the components of site-specific flood inventory.  

 Determine the minimal construction design characteristics required by Hazus. 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 10: Hazus Flood for Recovery  SM-199 

Visual 3: Flood Results: Results (1 of 4) 

00 Year Flood Map Explained:  

 Dark border lines (here in orange) 
designates the flood boundaries. 

 The shaded areas adjacent to the flood 
boundary line, which tends to be packed 
closer together in terms of their hidden 
contour lines, are unflooded areas at a 
higher elevation such as slopes, hills, 
mountains, and ideal population 
settlements.  

 For example, the northern and central 
areas of the map and the southeast area 
of the map. 

 The shaded areas (here in light to dark 
blue), which tends to be spread out or 
flatter in terms of their hidden contour 
lines, are flooded areas of the map.  

 For example, the southern and central 
areas of the map.  

 The lighter blue (shaded) areas that are 
closer to the flood boundary and higher ground depicts less than 1 foot of flooding. 
In contrast are the darker blue (shaded) areas further away from the flood boundary 
representing a decreasing slope in elevation resulting in a high of 32.776 feet of 
flooding above the ground elevation.  

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 10: Hazus Flood for Recovery  SM-200 

Visual 4: Flood Results 

 GBS: by amount of damage and by dollar losses  

 Essential facilities: building and content losses, functionality assessment, and 
restoration time  

 Lifeline losses: losses to structures, functionality assessment  

 Vehicle losses: day and night, by car or truck  

 Agriculture losses (Not reimbursed under FEMA PA) 

 Shelter requirements: displaced households and short-term needs  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 10: Hazus Flood for Recovery  SM-201 

Visual 5: Individual Assistance Program 

Provides:  

 Immediate Assistance (partners with other organizations)  

 FEMA help  

 Home/Primary Residence  

 Business/Secondary Home  

 Other (medical, dental, child care, storage, etc.)  

 Additional Assistance  

 Small Business Administration Application  

 Home Inspection  

 After the Inspection  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 10: Hazus Flood for Recovery  SM-202 

Visual 6: Final High Water Marks (HWM) 

 A measure of the event water surface elevation  

 Collected by either USGS or local governments 

 During periods of flooding, HWM elevations may be collected at the peak elevation 
using high-resolution GPS systems.  

 Values represent the most accurate depiction of the flood event.  

 Represent the highest extent of riverine flood or coastal storm surge inundation.  

 Represents the elevation of the water during the flood event and ‘fills in’ the gaps 
where water marks are not present  

 HWMs can be interpolated into depth grids for loss estimation 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 10: Hazus Flood for Recovery  SM-203 

Visual 7: Exercise 10.1: HWM Depth Grid 

Goal: Create a high water mark depth grid.  

 Time: 30 minutes  

 

 

Student 
Manual 

 

Exercise 10.1: HWM Depth Grid 

Goals: Create a high water mark depth grid.  

 Time: 30 minutes  

Activity Steps: 

1. Refer to Activities Document “10.1_Exercise_HWM Depth Grid.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Follow along to complete the task with the instructor.  

5. Complete the goal assigned.  

6. Ask any final questions.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 10: Hazus Flood for Recovery  SM-204 

Visual 8: Exercise 10.1: Tasks 

Task 1: Insert Interpolation of the Water Surface; Create Depth Grid.  

 Task 2: Subtract Water Surface Grid from the DEM.  

 Task 3: Remove Negative Values.  

 Task 4: Create the Flood Boundary.  
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Exercise 10.1: Tasks 

Refer to Activities Document “10.1_Exercise_HWM Depth Grid.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 10: Hazus Flood for Recovery  SM-205 

Visual 9: Site-Specific Flood Inventory 

 Essential Facilities  

 Transportation Infrastructure: All inventory can be entered, but only bridges are 
analyzed  

 Utilities: Additional classifications include control vaults and control stations  

 User-Defined Facilities: Used to perform a more refined site-specific analysis of 
inventory found in the GBS  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 10: Hazus Flood for Recovery  SM-206 

Visual 10: User-Defined Facilities 

Hazus requires minimal construction design characteristics to select the correct damage 
curve for damage and loss analysis for each facility:  

 Foundation type  

 Number of stories  

 First floor elevation  

 Specific occupancy  

 Building and contents valuations 

Applications: Explore 

 Explore Impact of fewer homes in floodplain  

 Outcome of elevating at-risk homes  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 10: Hazus Flood for Recovery  SM-207 

Visual 11: Lesson 10: Review 

1. What are some of the ways that FEMA provides help according to the Individual 
Assistance Program?  

2. What components are used for a site-specific flood inventory?  
3. What are the minimal construction design characteristics required by Hazus?  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 10: Hazus Flood for Recovery  SM-208 

Visual 12: Questions 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-209 

Lesson 11: Basic Earthquake 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-210 

Visual 1: Lesson 11: Basic Earthquake 

  

  

  

  

  

  

  

  

  

  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-211 

Visual 2: Lesson 11: Goal and Objectives 

Goal: To provide a review of the earthquake model within Hazus.  

 After completing this lesson you will be able to:  

 Explain earthquake basics and inventory parameters.  

 Describe the function and necessities of ShakeMap.  

 Differentiate between Fragility and Capacity Curves.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-212 

Visual 3: Where Do Earthquakes Happen? 

Most of world's active faults are located along 
or near boundaries between shifting plates  

 Plate Boundary earthquakes  

 Other active faults are not associated with 
plate boundaries and are inside plates  

 Intra-plate earthquakes 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-213 

Visual 4: GBS for Earthquakes 

 In addition to standard inventory, the GBS has attributes particular to the earthquake 
hazard 

 37 unique building types based on frame and height 

 Steel, concrete, masonry, wood, mobile homes 

 Low-rise, mid-rise, high-rise 

 Seven different design levels  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-214 

Visual 5: Earthquake Data Sources 

 National Earthquake Information Center (NEIC) 

 USCG: ShakeMaps for actual and scenario events 

 Regional earthquake consortia 

 CUSEC: soils and liquefaction susceptibility maps 

 State geologists 

 Local universities 
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Earthquake Data Sources 

 National Earthquake Information Center (NEIC)  

 USGS: ShakeMaps for actual and scenario events  

 Recent Events map: 
https://earthquake.usgs.gov/earthquakes/map/  

 Historic Event search: 
https://earthquake.usgs.gov/earthquakes/search/  

 Scenario Catalog: 
https://earthquake.usgs.gov/scenarios/catalog/  

 Regional earthquake consortia  

 CUSEC: soils and liquefaction susceptibility maps  
cusec.org/earthquake-maps-data/ 

 State geologists  

 Local universities 

 

http://earthquake.usgs.gov/earthquakes/map/
http://earthquake.usgs.gov/earthquakes/search/
http://earthquake.usgs.gov/scenarios/catalog/
http://cusec.org/earthquake-maps-data/


March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-215 

Visual 6: Hazus Earthquake Basics 

 Catastrophic Response Planning  

 Annualized Earthquake Loss Study (FEMA P.-366) 

 Earthquake results are sensitive to categories of inventory parameters  

 Location  

 Classification to earthquake vulnerability  

 Valuation  

 Societal  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-216 

Visual 7: Hazus Approach 

Evaluates ground motion parameters 

 At the location for site-specific inventory 

 At the centroid of the census tract for aggregate inventory 

Ground shaking characterized in terms of 

 Location-specific shaking 

 Spectral response 

 Peak ground values 

 Regional attenuation functions 

 Site-soil effects 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-217 

Visual 8: Hazus Approach (Cont'd.) 

Ground Failure shaking is characterized in terms of 
amount of ground failure due to liquefaction and 
landslide. 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-218 

Visual 9: USGS PAGER 

 Prompt Assessment of Global Earthquakes for Response  

 Provides fatality and economic loss impact estimates following significant 
earthquakes worldwide.  

 onePAGER: concise, printable version of the rapid assessment of estimated 
fatalities and economic losses delivered online and via email 

 NOTE: There is currently a joint USGS-FEMA effort underway to develop a PAGER 
2nd page, providing Hazus results for significant US earthquakes.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-219 

Visual 10: USGS PAGER Comparison 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-220 

Visual 11: USGS onePAGER Review 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-221 

Visual 12: USGS twoPAGER Review 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-222 

Visual 13: PAGER vs. Hazus 

PAGER: Exposure Model  

 Shaking intensity, population exposure, and loss estimates  

 Ground shaking impacts  

 Fatality and economic loss estimates given the exposure  

 Estimated results only  

Hazus: Loss Estimation Model  

 Ground shaking, fault rupture, liquefaction, land sliding, and tsunami impacts  

 Considers building density and composition  

 Site-specific and user-defined capabilities  

 Results options:  

 Quantitative estimates of direct and indirect losses  

 Functionality losses  

 Extent of induced hazards  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-223 

Visual 14: Defining a New Earthquake Scenario 

Deterministic 

 USGS ShakeMap* 

 Historical epicenter event 

 Source event 

 Arbitrary event 

Probabilistic 

User-Supplied  

*Preferred method 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-224 

Visual 15: ShakeMap 

ShakeMap is a product of the USGS Earthquake Hazards Program 

 Provide near-real-time maps of ground motion and shaking intensity following 
earthquakes 

 Used by federal, state, and local organizations (private and public) for: 

 Post-earthquake response and recover 

 Public and scientific information 

 Preparedness exercises 

 Disaster planning 

 Provides maps on intensity, acceleration, velocity, and uncertainty of earthquakes 

 ShakeMap data download options include: XML grids, rock grid, uncertainty grid, 
text ASCII grids, KML, KMZ, Shapefiles, general-purpose GIS files, ESRI raster files, 
text metadata, and other supplementary maps and images 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-225 

Visual 16: ShakeMap 

ShakeMaps for Hazus must include a file with the following parameters:  

 Peak Ground Acceleration (PGA)  

 Peak Ground Velocity (PGV)  

 Spectral Acceleration at 1 second (psa10)  

 Spectral Acceleration at 0.3 seconds (psa03)  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-226 

Visual 17: Demonstration 11.1: ShakeMap 

Goal: Use the Hazus interface to find a ShakeMap.  

 Time: 25 minutes  
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Demonstration 11.1: ShakeMap 

Goal: Use the Hazus Interface to find a ShakeMap  

 Time: 25 minutes  

 Demonstration Steps:  

1. Refer to Activities Document “11.1_Demonstration_ShakeMap.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Watch the instructor’s demonstration.  

5. Ask any final questions.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-227 

Visual 18: Demonstration 11.1: Tasks 

Task 1: Create a New Salt Lake City Study Region.  

 Task 2: Open Salt Lake City Study Region.  

 Task 3: Use Hazus Interface to Define USGS ShakeMap.  

 Task 4: View Direct Economic Loss.  
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Demonstration 11.1: Tasks 

Refer to Activities Document “11.1_Demonstration_ShakeMap.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-228 

Visual 19: Using Hazard Maps 

Simplified hazard maps are automatically generated during the creation of the study 
region. These approximate hazard maps are based on default soil maps and the census 
tract boundaries.  

 Users can modify and enhance soils, liquefaction, landslide and water depth if spatial 
data is available from experts or other agencies.  

 If available, these expert-generated maps should be used to replace the simplified 
maps. 

Hazard maps should be used when default data may not represent actual conditions or 
to model historical scenarios. If improved hazard maps are not available, the site class 
of each hazard for the study region can be changed. 

Note: Soil hazard maps should not be used with ShakeMaps. 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-229 

Visual 20: Importing Hazard Maps 

 

 

 Import user-defined maps to create more detailed analysis 

 Expertly generated ground motion and soils maps can enhance the quality of your 
results. 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-230 

Visual 21: Define Hazard Maps Option 

 

Hazard map options: 

 Apply same value to the entire region 

 Import hazard maps so that Hazus can generate more accurate ground motion data 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-231 

Visual 22: User-Defined Hazard Option 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-232 

Visual 23: Exercise 11.2: Source Event 

Goals:  

 Create a Source Event Scenario.  

 Create a map of economic loss.  

 Time: 25 minutes  
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Exercise 11.2: Source Event 

Goals:  

 Create a Source Event Scenario.  

 Create a map of economic loss.  

 Time: 25 minutes  

 Exercise Steps:  

1. Refer to Activities Document “11.2_Exercise_Source Event.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed.  

6. Complete the assigned goal.  

7. Be prepared to share your answers/results.  

8. Ask any final questions.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-233 

Visual 24: Exercise 11.2: Tasks 

Task 1: Open Study Region Salt_Lake_City_EQ.  

 Task 2: Define the Scenario.  

Task 3: Add a Soil Map and Define the Data.  

Task 4: Run Analysis.  

Task 5: View Direct Economic Loss Results.  
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Exercise 11.2: Tasks 

Refer to Activities Document “11.2_Exercise_Source Event.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-234 

Visual 25: Capacity Curves 

 

 Characterize building response (e.g. displacement) resulting from input ground 
motion 

 Lognormal distribution of being in or exceeding damage state  

 Estimated displacement is used with the Fragility Curve to determine damage state 
probabilities 

 Capacity curves are described by: 

 Design capacity – strength of a building  

 Yield capacity – point where a building experiences damage  

 Ultimate capacity – point where a building is completely destroyed  

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-235 

Visual 26: Fragility Curves 

 

 Damage functions for earthquakes  

 Lognormal distribution of being in or exceeding damage state  

 Considers variability of damage state due to:  

 Uncertainty of damage state threshold  

 Variability in building capacity  

 Spatial variability of ground motion  

 Depending on the level of earthquake forces, damage to building can range from no 
damage to complete damage  

 Uncertainty  

  

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-236 

Visual 27: Lesson 11: Review 

1. List four categories of inventory parameters that earthquake results are sensitive to.  
2. What is a ShakeMap and what types of data does it use?  
3. What parameters must be included in ShakeMap for Hazus?  
4. What is the difference between a Fragility Curve and a Capacity Curve?  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 11: Basic Earthquake  SM-237 

Visual 28: Questions 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-238 

Lesson 12: Hazus Earthquake for 
Response 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-239 

Visual 1: Lesson 12: Hazus Earthquake for 

Response 

  

  

  

  

  

  

  

  

  

  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-240 

Visual 2: Lesson 12: Goal and Objectives 

Goal: To understand basics of modeling earthquakes for response in Hazus.  

 After completing this lesson you will be able to:  

 Describe the earthquake response timeline.  

 Summarize the quantification of the hazards for an earthquake.  

 Explain the characteristics of ground shaking.  

 List the data sources used for Hazus for Earthquakes.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-241 

Visual 3: Federal Response 

 USGS Earthquake Notification Service (ENS)  

 Free email notification service  

 Default magnitude of 6.0 in U.S. (can be user modified)  

 PAGER Yellow Alert: regional impact and response  

 PAGER Orange Alert: national-scale impact and response  

 Support efforts of state and local governments  

 FEMA’s Natural Hazards Risk Assessment program will contain loss data scenarios 
beginning 2019  

 Based on ShakeMaps, Hazus Loss results, PAGER (page 1) and PAGER (page 
2)  

 Earthquake Notification Service: earthquake.usgs.gov/ens/userhome_map 

  

 

http://earthquake.usgs.gov/ens/userhome_map


March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-242 

Visual 4: USGS ShakeMap 

 ShakeMaps provide near-real-time maps 
of ground motion and shaking intensity 
following significant earthquakes  

 ShakeMaps also contain archives of 
previous earthquakes 

 Will show earthquakes in the last 90 days 
by default - to add historic or scenario 
events, make selection and expand 
search parameters. 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-243 

Visual 5: Direct Physical Damage 

Hazus assesses the maximum displacement 
that a building will undergo and the damages 
that would result 

Damages vary according to 

 Uncertainty of damage state threshold 

 Variations in building capacity 

 Geographic variations of ground motion 

Analyzes both structural and non-structural 
elements 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-244 

Visual 6: Direct Physical Damage 

 Essential Facilities  

 Fire Stations, Police Stations, Hospitals and Clinics, Schools, Emergency 
Operations Centers 

What can Hazus provide the community/State decision-makers?  

 Parameters 

 Facility Damage  

 Restoration Time 

 Based on ground shaking and ground failure  

Why is this data critical for emergency planning?  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-245 

Visual 7: Direct Physical Damage 

Transportation:  

 Highway, Railway, Light Rail, Bus, Port, 
Ferry, Airport 

Parameters 

 Facility Damage 

 Time to Restore Facility 

 Economic Loss Estimations 

When and in what form should this be 
provided to leadership?  

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-246 

Visual 8: Direct Physical Damage 

Utilities:  

 Potable Water, Waste Water, Oil 
Systems, Natural Gas, Electric Power and 
Communication 

Parameters 

 Facility Damage 

 Time to Restore Facility 

 Economic Loss Estimations 

Following an earthquake, how can Hazus 
facilitate recovery operations?  

 

Broken utilities, Watsonville Area, Loma 
Prieta, 1989 (USGS) 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-247 

Visual 9: Social Losses - Casualties 

Calculates multiple levels of casualties based 
on severity and time of day 

Parameters 

 Damage to various Building Types 

 Bridge Damage Contribution 

 Time Dependent 

 

Spence and So. 2009. “Estimating Shaking-
Induced Casualties and Building Damage for 
Global Earthquake Events" 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-248 

Visual 10: Social Losses - Shelter 

Calculates need for public shelters 

Parameters 

 Age 

 Ethnicity 

 Income 

 Home Ownership 

 Damage states of different types of 
buildings 

What information and recommendations can 
Hazus provide leadership?  

 

Red Cross shelter; Minot, ND; June 24, 2011 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-249 

Visual 11: Debris 

Parameters 

 Weight of structural and nonstructural 
model building types 

 Probabilities of damage states for 
structural and nonstructural elements by 
census tract 

Why is this information critical for recovery 
operations?  

 

Damage in the Old Town historical district, 
City of Salinas, Loma Prieta, 1989 (USGS). 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-250 

Visual 12: Direct Economic Loss 

Parameters  

 Annual Gross Sales  

 Restoration Time  

 Income and Wage Losses  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-251 

Visual 13: Running the Analysis 

User picks modules they wish to run 

Modules can be re-run as needed 

Only select the analysis you need (speeds up 
processing time)  

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-252 

Visual 14: Exercise 12.1: ShakeMap 

Goals:  

 Import a ShakeMap.  

 Create a map of economic loss.  

 Time: 25 minutes 

 

 

Student 
Manual 

 

Exercise 12.1: ShakeMap 

Goals:  

 Import a ShakeMap.  

 Create a map of economic loss.  

 Time: 25 minutes    

Exercise Steps:  

1. Refer to Activities Document “12.1_Exercise_ShakeMap.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed.  

6. Complete the assigned goal.  

7. Be prepared to share your answers/results.  

8. Ask any final questions.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-253 

Visual 15: Exercise 12.1: Tasks 

Task 1: Open study region Salt_Lake_City_EQ.   

Task 2: Define the Scenario.   

Task 3: Run Analysis.  

 Task 4: View Direct Economic Loss Results.  

 

 

Student 
Manual 

 

Exercise 12.1: Tasks 

Refer to Activities Document “12.1_Exercise_ShakeMap.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-254 

Visual 16: Lesson 12: Review 

1. How is the hazard of an earthquake quantified?  
2. How is ground shaking characterized?  
3. What are the data sources used for Hazus for Earthquake  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 12: Hazus Earthquake for Response  SM-255 

Visual 17: Questions 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 13: Hazus Earthquake for Recovery  SM-256 

Lesson 13: Hazus Earthquake for 
Recovery 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 13: Hazus Earthquake for Recovery  SM-257 

Visual 1: Lesson 13: Hazus Earthquake for 

Recovery 

  

  

  

  

  

  

  

  

  

  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 13: Hazus Earthquake for Recovery  SM-258 

Visual 2: Lesson 13: Goal and Objectives 

 Goal: To understand the applications of the Hazus Earthquake Loss Estimation Model 
for recovery operations.  

 After completing this lesson you will be able to:  

 Identify sources of data.  

 Interpret loss estimations for recovery operations.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 13: Hazus Earthquake for Recovery  SM-259 

Visual 3: Collecting Local Data 

 State, county, and city governments  

 Earth science experts and universities  

 Recommend updating inputs such as:  

 Ground shaking maps: region-wide ground motion contour maps  

 Soil conditions  

 Critical Infrastructure and Key Resources (CIKR) 

 Local traffic models, including roads and bridges  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 13: Hazus Earthquake for Recovery  SM-260 

Visual 4: Recovery Activities 

 Actions taken to return to or exceed pre-earthquake levels of activity and productivity  

 Short-term and long-term activities  

 Restoring, repairing, and reconstructing lifelines and buildings  

 Undertaking measures to overcome economic downturns  

 Providing financial assistance to compensate for losses  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 13: Hazus Earthquake for Recovery  SM-261 

Visual 5: Long-Term Efforts 

 Reconstruct and restore the earthquake-stricken area  

 Deal with the disruption that the disaster has caused  

 Mitigate future hazards  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 13: Hazus Earthquake for Recovery  SM-262 

Visual 6: Mitigation 

 Can impact a community’s ability to recover  

 Example: earthquake insurance 

 Lessens financial burden on individuals and governments to replace damaged 
property  

 Frees up resources that can be applied to other recovery efforts  

 Hazard Mitigation Grant Program (HMGP) supports state and local government 
planning.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 13: Hazus Earthquake for Recovery  SM-263 

Visual 7: Exercise 13.1: ShakeMap with UDF 

Goals:  

 Run a ShakeMap Analysis with UDF Results. 

 Create a map of economic loss.  

  Time: 35 minutes  

 

 

Student 
Manual 

 

Exercise 13.1: ShakeMap with UDF 

Goals:  

 Run a ShakeMap Analysis with UDF Results.  

 Create a map of economic loss.  

 Time: 35 minutes    

Exercise Steps:  

1. Refer to Activities Document “13.1_Exercise_ShakeMap with 
UDF.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed.  

6. Complete the assigned goal.  

7. Be prepared to share your answers/results.  

8. Ask any final questions.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 13: Hazus Earthquake for Recovery  SM-264 

Visual 8: Exercise 13.1: Tasks 

Task 1: Create a New Study Region.  

 Task 2: Open Salt Lake City Study Region.  

 Task 3: Add a ShakeMap.  

 Task 4: Run an Earthquake Analysis.  

 Task 5: View Direct Economic Loss Results.  

 

 

Student 
Manual 

 

Exercise 13.1: Tasks 

Refer to Activities Document “13.1_Exercise_ShakeMap with UDF.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 13: Hazus Earthquake for Recovery  SM-265 

Visual 9: Discussion 13.2: ShakeMap  

Question: How did including UDF change the earthquake run?  

 Time: 10 minutes  

 

 

Student 
Manual 

 

Discussion 13.2: ShakeMap  

Question: How did including UDF change the earthquake run?  

 Time: 10 minutes  

 Discussion Steps:  

1. Listen to instructor’s directions.  

2. Ask questions if they need directions clarified.  

3. Discuss the questions with the class.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 13: Hazus Earthquake for Recovery  SM-266 

Visual 10: Lesson 13: Review 

1. What are some potential sources of updated input data for Hazus?  
2. What are some examples of recovery activities?  
3. What are the general steps involved in viewing direct economic loss results from an 

earthquake?  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 13: Hazus Earthquake for Recovery  SM-267 

Visual 11: Questions 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-268 

Lesson 14: Basic Tsunami 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-269 

Visual 1: Lesson 14: Basic Tsunami 

  

  

  

  

  

  

  

  

  

  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-270 

Visual 2: Lesson 14: Goal and Objectives 

Goal: To provide a review of the tsunami model within Hazus 

 After completing this lesson you will be able to:  

 Define tsunami.   

 Differentiate between near and distant source tsunamis.  

 Understand tsunami-specific inventory. 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-271 

Visual 3: Tsunami Overview 

A series of long-period waves that are usually generated by an impulsive disturbance 
that displaces massive amounts of water  

 Travels at speeds of > 450 mph across the ocean, slowing as it approaches 
shallower water  

 A series of waves with minutes to hours between – the first wave may not be the 
largest  

 Encompass the entire water column in open ocean, with an average surface height 
of 0.5 m 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-272 

Visual 4: Tsunami Overview 

Tsunamis can be triggered by  

 earthquakes  

 volcanic activity  

 submarine landslides  

 onshore landslides in which large volumes of debris fall into the water  

All of these triggers can occur in the United States 

Most of the tsunamis (88%) in the Global Historical Tsunami Database were generated 
by earthquakes or landslides caused by earthquakes 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-273 

Visual 5: Hazus Tsunami Model 

 Loss estimation model that provides state-of-the-art decision support software for 
estimating potential losses from tsunamis.  

 Available for 5 Very High-risk states (AK, WA, OR, CA, HI) and the 5 High Risk U.S. 
territories  

 Combined Earthquake/Tsunami analysis functionality available for the 5 states and 
PR 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-274 

Visual 6: Tsunami - Near vs Distant Source 

Near Source (local source)  

 Those generated within 100 km of a 
locality of interest  

 Earthquake ground shaking precedes the 
tsunami  

 Earthquake damage possible  

 Subsidence (lowering) of coastal area 
possible  

 Lead time – a few minutes to an hour 

 

Credit: USGS 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-275 

Visual 7: Tsunami - Near vs Distant Source 

Distant Source 

 Those generated far away (>1,000 km from a locality) 

 No ground shaking precedes the tsunami 

 Lead time – few to several hours 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-276 

Visual 8: Available Data 

 Census Bureau: road networks  

 NOAA  

 National Center for Environmental Information: tsunami events, runups, deposits  

 Bathymetry, seismic activity, real-time data  

 State governments  

 Hawaii: tsunami zones, evacuation zones, wave heights, parcels, terrestrial  

 US Tsunami Warning System  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-277 

Visual 9: National Structure Inventory (NSI) 

 U.S. Army Corp of Engineers’ National Structural Inventory point data. Developed 
with FEMA.  

 Creates notional structures, or ‘points,’ in the developed portion of each census 
block to represent the numbers and types of buildings that occur based on size, 
occupancy type, construction materials, etc. 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-278 

Visual 10: User Defined Facilities 

 Enables user specific datasets to be analyzed through the Hazus methodologies 
providing more accurate results 

 User populated table using Hazus CDMS  

 Attributes include:  

 Occupancy type  

 Earthquake building type  

 Design level  

 First floor height  

 Building replacement cost  

 Content replacement cost  

 Location of structure 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-279 

Visual 11: Exercise 14.1: Tsunami Study Region 

Goal: Build a tsunami study region.  

 Time: 15 minutes  

 

 

Student 
Manual 

 

Exercise 14.1: Tsunami Study Region 

Goal: Build a study region for Tsunami.  

 Time: 15 minutes    

Exercise Steps:  

1. Refer to Activities Document “14.1_Exercise_Tsunami Study 
Region.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed.  

6. Complete the assigned goal.  

7. Be prepared to share your answers/results.  

8. Ask any final questions.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-280 

Visual 12: Exercise 14.1: Tasks 

Task 1: Build a Tsunami Study Region.  

 Task 2: Open the Region and Input Tsunami User Data.  

 

 

Student 
Manual 

 

Exercise 14.1: Tasks 

Refer to Activities Document “14.1_Exercise_Tsunami Study Region.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-281 

Visual 13: Lesson 14: Review 

1. What are the characteristics of a tsunami?  
2. List the incidents that can trigger a tsunami.  
3. What is the differences between a tsunami approaching the coast and tsunamis 

occurring near the coast?  
4. How does the National Structure Inventory work with Hazus?  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 14: Basic Tsunami  SM-282 

Visual 14: Questions 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-283 

Lesson 15: Hazus Tsunami for 
Response and Recovery 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-284 

Visual 1: Lesson 15: Hazus Tsunami for 

Response and Recovery 

  

  

  

  

  

  

  

  

  

  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-285 

Visual 2: Lesson 15: Goal and Objectives 

 Goal: To describe the levels of analysis and applications for estimating losses and 
casualties.  

 After completing this lesson you will be able to:  

 List the steps for estimating tsunami losses.  

 Describe the steps for estimating tsunami casualties.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-286 

Visual 3: Levels of Tsunami Analysis 

Basic (Level 1)  

 Out-of-the-box default infrastructure  

 Basic user input  

 Advanced (Level 2/3)  

 User-provided data - more accurate to the region  

 Data provided by third-party studies/hazard models  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-287 

Visual 4: Hazus Analysis Components 

Hazard Input  

 Tsunami inundation depth  

 Velocity or momentum flux  

 Topography  

 Run-up Height 

Infrastructure  

 NSI data (point location – aggregated)  

 User defined structures  

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-288 

Visual 5: Hazus Analysis Components 

Damage and Losses  

 Direct damage to structures, contents and nonstructural elements  

 Direct economic losses  

Casualties  

 Evacuation times  

 Injury/Fatality estimates  

 Age, time of day, community preparedness  

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-289 

Visual 6: Hazard Analysis - User Input 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-290 

Visual 7: Level 1 Analysis 

 Requires user input data 

 Level 1 outputs are the inputs needed for levels 2 and 3 analysis 

 Runup Only-Mean Sea Level (MSL) and Quick Look-Single Maximum Runup 
outputs: 

 Median Inundation Depth (ft) 

 Median Momentum Flux (ft3/sec2)  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-291 

Visual 8: Casualty Scenario 

Level 1 - Input:  

 Fatality Boundary (depth > 2m)  

 Hazard Boundary (depth > 0)  

 Road Network Data  

 Topography (DEM)  

 Estimated time of tsunami arrival and maximum runup  

 Level 2 - Input:  

 Output travel time results provided by the USGS Pedestrian Evacuation Analyst Tool  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-292 

Visual 9: Road Network Data 

Casualty Level 1 assumes a ‘roads only’ analysis, in that the population will follow the 
road network to safety  

 The Census TIGER road networks data may be downloaded through the Hazus 
Tsunami model from the Analysis Menu, under Casualty  

 Or directly from the Census website at: 2016 TIGER/Line Shapefiles: Roads 
(https://www.census.gov/cgi-
bin/geo/shapefiles/index.php?year=2016&layergroup=Roads)  

 

 

 

 

http://www.census.gov/cgi-bin/geo/shapefiles/index.php?year=2016&layergroup=Roads


March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-293 

Visual 10: Casualty Assessment Results 

 Estimates pedestrian evacuation, and warning times to evaluate potential loss of life 
and injuries  

 Two levels of analysis: Basic and Advanced  

 Results:  

 Evacuation Travel Time (Age – Under/Over 65)  

 Day/Night population exposure  

 Day/Night probability of casualties  

 Casualties based on Community Preparedness Level (good, fair, poor) 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-294 

Visual 11: Exercise 15.1:  Tsunami 

Goal: Run a Tsunami Level-1 analysis.   

 Time: 30 minutes  

 

 

Student 
Manual 

 

Exercise 15.1:  Tsunami 

Goal: Run a Tsunami Level-1 analysis.    

 Time: 30 minutes  

Exercise Steps: 

1. Refer to Activities Document “15.1_Exercise_Tsunami Analysis.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed. 

6. Complete the assigned goal.  

7. Be prepared to share your answers/results.  

8. Ask any final questions.  

  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-295 

Visual 12: Exercise 15.1: Tsunami 

Task 1: Open the Study Region.  

Task 2: Run a Level 1 Analysis: Runup Only-Mean Sea Level.  

 Task 3: Run a Level 1 Casualty Analysis.  

 

 

Student 
Manual 

 

Exercise 15.1: Tasks 

Refer to Activities Document “15.1_Exercise_Tsunami Analysis.”  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-296 

Visual 13: Lesson 15: Review 

1. What are the steps for estimating tsunami losses?  
2. How does Hazus estimate tsunami casualties?  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 15: Hazus Tsunami for Response and Recovery  SM-297 

Visual 14: Questions 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 16: Hazus Earthquake and Tsunami Combined Analysis  SM-298 

Lesson 16: Hazus Earthquake and 
Tsunami Combined Analysis 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 16: Hazus Earthquake and Tsunami Combined Analysis  SM-299 

Visual 1: Lesson 16: Hazus Earthquake and 

Tsunami Combined Analysis 

  

  

  

  

  

  

  

  

  

  

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 16: Hazus Earthquake and Tsunami Combined Analysis  SM-300 

Visual 2: Lesson 16: Goal and Objectives 

 Goal: To understand the interrelationships between earthquakes and tsunamis in 
Hazus modeling.  

 After completing this lesson you will be able to:  

 Explain the relationship between earthquakes and tsunamis.  

 Identify the factors necessary for a combined analysis.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 16: Hazus Earthquake and Tsunami Combined Analysis  SM-301 

Visual 3: Earthquake and Tsunami Basics 

 Near source scenarios: earthquake starts the tsunami 

 Strike-slip fault: vertical fractures where the blocks have mostly moved horizontally 

 Thrust fault: reverse fault with a dip of 45° degrees or less 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 16: Hazus Earthquake and Tsunami Combined Analysis  SM-302 

Visual 4: Earthquake Strength 

Magnitude Effect 

< 6.5 Earthquakes of this magnitude 
are very unlikely to trigger a 
tsunami. 

6.5 - 7.5 Earthquakes of this size do not 
usually produce destructive 
tsunamis. However, small sea 
level changes may be observed 
in the vicinity of the epicenter. 
Tsunamis capable of producing 
damage or casualties are rare in 
this magnitude range but have 
occurred due to secondary 
effects such as landslides or 
submarine slumps. 

7.6 - 7.8 Earthquakes of this size may 
produce destructive tsunamis 
especially near the epicenter; at 
greater distances small sea level 
changes may be observed. 
Tsunamis capable of producing 
damage at great distances are 
rare in this magnitude range. 

> 7.8 Destructive local tsunamis are 
possible near the epicenter, and 
significant sea level changes and 
damage may occur in a broader 
region. Note that with a 
magnitude 9.0 earthquake, the 
probability of an aftershock with a 
magnitude exceeding 7.5 is not 
negligible. 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 16: Hazus Earthquake and Tsunami Combined Analysis  SM-303 

Visual 5: Near Source – Deformed DEM 

 Post-earthquake event deformed 
topography should be used in the case of 
a near source scenario  

 Earthquake could result in several meters 
of ground deformation, which may 
substantially change the inundation area 
and affect potential losses resulting from a 
tsunami  

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 16: Hazus Earthquake and Tsunami Combined Analysis  SM-304 

Visual 6: Analysis Options 

  

Earthquake Tsunami 

 General buildings  

 Essential facilities  

 Military installation: Advanced 
Engineering Building Module (AEBM)  

 User-defined structures  

 Utility systems  

 Induced physical damage  

 Direct social losses  

 Indirect economic impact  

 General Building Stock 

 User-defined facilities 

 Direct damages 

 Functionality and economic loss 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 16: Hazus Earthquake and Tsunami Combined Analysis  SM-305 

Visual 7: Combined Analysis Options 

 Combined General Building Stock  

 Direct damages (by count and by square footage) 

 Direct economic loss  

 Combined User-Defined Facilities  

 Direct damages (damage state) 

 Functionality 

 Economic loss  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 16: Hazus Earthquake and Tsunami Combined Analysis  SM-306 

Visual 8: Exercise 16.1: Combined Earthquake 

and Tsunami 

Goal: Run a combined near source earthquake and tsunami analysis.  

 Time: 60 minutes  

 

 

Student 
Manual 

 

Exercise 16.1: Combined Earthquake and Tsunami 

Goal: Run a combined near source earthquake and tsunami analysis.  

 Time: 60 minutes  

Exercise Steps: 

1. Refer to Activities Document “16.1_Exercise_Combined 
Earthquake and Tsunami.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Work individually on the goal.  

5. Ask questions to the instructor if needed. 

6. Complete the assigned goal.  

7. Be prepared to share their answers/results.  

8. Ask any final questions.  
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Visual 9: Exercise 16.1: Combined Earthquake 

and Tsunami 

Task 1: Open your Tsunami Study Region.   

 Task 2: Download Near Source Earthquake ShakeMap.  

Task 3: Open ShakeMap in Hazus and Run an Analysis.  

Task 4: Explore Earthquake Results.  

Task 5: Run a Tsunami Analysis.  

Task 6: Run the Combined Analysis.  

Task 7: Download the Roadways and Run a Level 1 Casualty Analysis.  

Task 8: Explore Tsunami and Combined Analysis Results.  

 

 

Student 
Manual 

 

Exercise 16.1: Tasks 

Refer to Activities Document “16.1_Exercise_Combined Earthquake 
and Tsunami.”  
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Visual 10: Lesson 16: Review 

1. How are earthquakes and tsunamis related?  
2. What type of model is most appropriate for a combined analysis?  
3. What are the analysis options for a combined tsunami and earthquake scenario?    
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Visual 11: Questions 
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Lesson 17: Hazus Products and 
Communication 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 17: Hazus Products and Communication  SM-311 

Visual 1: Lesson 17: Hazus Products and 

Communication 
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Visual 2: Lesson 17: Goal and Objectives 

 Goal: To understand how Hazus can be used to generate meaningful communication 
products.  

 After completing this lesson you will be able to:  

 List various examples of online mapping platforms.  

 Explain the benefits of online communications.  

 Describe the benefits of static maps. 
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Visual 3: Packaging Data 

 Any mapped layer can be exported as a shapefile or geodatabase feature class.  

 Output file types: feature class, table, database, shapefile, raster  

 Geodatabases: store multiple feature classes  

 Shapefiles must be zipped before sending 

 HPRs: include SQL tables and hazard datasets  

 If you do not have Hazus, you can still view HPRs in ArcMap 

 Change HPR to zip file and connect to SQL 
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Visual 4: Hazus Export Tool 

 Script that exports results from Hazus 
study regions 

 C:\Program Files (x86)\Hazus-
MH\BIN\Tools 

 Creates a geodatabase 
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Visual 5: Hazus Reports 

 Consolidate data and provide summary findings 

 Valuable tools in communicating to decision makers 

 Options vary for different hazards  
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Visual 6: Hazus Reports 
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Visual 7: Activity 17.1: Packaging Data 

Goals:  

 Export UDF shapefile.  

 Export HAZUS HPR file.  

 Time: 15 minutes  

 

 

Student 
Manual 

 

Activity 17.1: Packaging Data 

Goals:  

 Export UDF shapefile.  

 Export HAZUS HPR file.  

 Time: 15 minutes  

Activity Steps: 

1. Refer to Activities Document “17.1_Activity_Packaging Data.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Follow along to complete the task with the instructor.  

5. Complete the goal assigned.  

6. Ask any final questions.  
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Visual 8: Activity 17.1: Tasks 

Task 1: Open a Study Region.  

Task 2: Export the UDF Data.  

Task 3: Export Hazus HPR. 

 

 

Student 
Manual 

 

Activity 17.1: Tasks 

Refer to Activities Document “17.1_Activity_Packaging Data.”  
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Visual 9: Secure File Transfer Protocol (sFTP) 

 Push to sFTP for distribution.  

 FEMA Cloud GIS Infrastructure Production Site: https://data.femadata.com/ 

 Esri Site: https://mft.esri.com/ 

 Often a predetermined life span of the data.  

 

http://data.femadata.com/
http://mft.esri.com/
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Visual 10: Demonstration 17.2: sFTP 

Distribution 

Goal: Explore WinSCP in accessing FEMA data repository.  

 Time: 10 minutes  

 

 

Student 
Manual 

 

Demonstration 17.2: sFTP Distribution 

Goal: Explore WinSCP in accessing FEMA data repository. 

 Time: 10 minutes  

Demonstration Steps: 

1. Listen to instructor’s directions.  

2. Ask questions if clarification is needed.  

3. Watch the instructor’s demonstration.  

4. Ask any final questions.  
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Visual 11: Demonstration 17.2: Tasks 

Task 1: Open WinSCP and Log-in.  

 Task 2: Navigate to Desired Destination Folder.  

 Task 3: Upload File(s).  

 Task 4: View Online Destination.  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 17: Hazus Products and Communication  SM-322 

Visual 12: GIS Online 

 Esri products: ArcGIS Online  

 Map Viewer 

 Story Maps 

 Dashboards  

 CartoDB  

 Tableau  

 Government GeoPlatform 
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Visual 13: Activity 17.3: ArcGIS Online 

Goal: Explore ArcGIS Online as an online option for creating maps and communication 
information.  

 Time: 20 minutes  

 

 

Student 
Manual 

 

Activity 17.3: ArcGIS Online 

Goal: Explore ArcGIS Online as an online option for creating maps 
and communication information.  

 Time: 20 minutes  

Activity Steps: 

1. Refer to Activities Document “17.3_Exercise_ArcGISOline.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Follow along to complete the task with the instructor.  

5. Complete the goal assigned.  

6. Ask any final questions.  
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Visual 14: Activity 17.3: Tasks 

Task 1: Go to ESRI's site to access ArcGIS Online.  

Task 2: Load data of your choice.  

Task 3: View online map.  

Task 4: View geoplatform.gov 

 

 

Student 
Manual 

 

Activity 17.3: Tasks 

Refer to Activities Document “17.3_Exercise_ArcGISOnline.”  
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Visual 15: Static Maps 

 Standalone images that do not require a mapping library or API  

 Easy option for printing maps or embedding maps on a webpage.  

 May be created through:  

 Screenshots of interactive maps  

 Export from mapping platform  
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Visual 16: Activity 17.4: Static Maps 

Goal: Create a static map from the results of one of the activities you completed in this 
course.  

 Time: 10 minutes  

 

 

Student 
Manual 

 

Activity 17.4: Static Maps 

Goal: Create a static map from the results of one of the activities you 
completed in this course.  

 Time: 10 minutes  

Activity Steps: 

1. Refer to Activities Document “17.4_Activity_Static Maps.”  

2. Listen to instructor’s directions.  

3. Ask questions if clarification is needed.  

4. Follow along to complete the task with the instructor.  

5. Complete the goal assigned.  

6. Ask any final questions.  
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Visual 17: Activity 17.4: Tasks 

Task 1: Open Region and Scenario of Your Choice.  

Task 2: Define Resolution (default 300 dpi) and Output Image Quality.    

 

 

Student 
Manual 

 

Activity 17.4: Tasks 

Refer to Activities Document “17.4_Activity_Static Maps.”  
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Visual 18: Communication of Data 

 Cartographic design  

 Spatial and temporal elements  

 Uncertainty and error  

 Embedding disclaimers into maps 
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Visual 19: Lesson 17: Review 

1. What are some examples of online mapping platforms?  
2. What are the benefits of online communications?  
3. What are the benefits of static maps?   
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Visual 20: Questions 
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Lesson 18: Capstone Exercise 
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Visual 1: Lesson 18: Capstone Exercise 
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Visual 2: Lesson 18: Goal and Objectives 

 Goal: To complete and present the Capstone Exercise 

 Objectives:  

 Develop Tabletop Exercise Materials 

 Formulate PowerPoint presentation 

 Present to class  
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Visual 3: Capstone Exercise Explanation 

 Scenario: Disaster Operations Response and Recovery agencies are enacting a 
tabletop exercise modeling their response to a natural disaster.  

 You, as Hazus experts will act as the GIS analysts using Hazus to support the 
tabletop exercise.  

 The type of tabletop exercise is up to you.  

 Create maps and other Hazus products to facilitate the exercise. 

 Each group will present while the remaining participants assume the role of the 
leadership team.  

 Present and explain the type of tabletop exercise you are supporting.  

 Present and explain the materials you produced and why you produced those 
specifically.  
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Visual 4: Capstone Exercise Explanation 

Presentation Guidelines:  

 Should be prepared using PowerPoint.  

 Include maps, tables, or other media you deem appropriate and helpful for 
conveying your message.  

 Information should be primarily derived from Hazus, but may be supplemented by 
other sources. 

 10-15 minutes in length; allowing 5 minutes for questions.  

Leadership Team Guidelines:  

 Class and instructor will assume the role of the leadership team. 

 Leadership team may ask questions related to the presentation.  
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Visual 5: Capstone Exercise Preparation 

 Time allowed to work on presentations 

 Break as needed 
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Visual 6: Questions 
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Lesson 19: Course Wrap-Up 
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Visual 1: Lesson 19: Wrap-Up 
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Visual 2: Lesson 19: Goal and Objectives 

 Goal: To review the major themes of the course and discuss opportunities for learning 
more about Hazus.  

 After completing this lesson you will be able to:  

 Identify courses and other training opportunities available to enhance your Hazus 
skills.  

 Identify additional resources available to explore to enhance your Hazus experience.  
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Visual 3: Additional Training 

 Classroom Courses:  

 E0170: Hazus for Hurricanes  

 E0172: Hazus for Floods  

 E0174: Hazus for Earthquake and Tsunami 

 E0177: Advanced Hazus Applications (coming soon) 

 E0190: ArcGIS for Emergency Managers 

 E0313: Basic Hazus  

 E0317: Comprehensive Data Management for Hazus 
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Visual 4: Become A Hazus Expert! 

 Hazus Trained User  

 E0190 ArcGIS for Emergency Managers (or prior GIS experience may substitute)  

 E0313 Basic Hazus  

 E0317 Comprehensive Data Management (CDMS) 

 Minimum of Two of the follow: 

 E0170 Hazus for Hurricanes 
 E0172 Hazus for Floods 
 E0174 Hazus for Earthquakes and Tsunami 

 Hazus Practitioner  

 E0190 ArcGIS for Emergency Managers (or prior GIS experience may 
substitute)   

 E0313 Basic Hazus 

 E0317 Comprehensive Data Management (CDMS)  

 Minimum of two of the follow:  

 E0170 Hazus for Hurricanes 
 E0172 Hazus for Floods 
 E0174 Hazus for Earthquakes and Tsunami  

 E0177 Advanced Hazus Applications  

 E0179 Hazus for Disaster Operations 
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Visual 5: Hazus Community Participation 

 Annual Hazus User Conference Hazus  

 Quarterly Newsletter  

 National Hazus User Group calls  

 Local Hazus User Groups  

 Hazus Outreach Email: hazus-outreach@riskmapcds.com  

 

 

 

 

mailto:hazus-outreach@riskmapcds.com
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Visual 6: Getting Help 

Hazus Help Desk - email  

hazus-support@riskmapcds.com 

 Consult the User Manuals and Technical Manuals  

https://www.fema.gov/hazus-mh-user-technical-manuals  

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Lesson 19: Course Wrap-Up  SM-345 

Visual 7: FEMA Hazus Website 

Primary FEMA resource for updated Hazus information:  
FEMA Hazus Website: https://www.fema.gov/hazus  

 

 

 

 

http://www.fema.gov/hazus
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Visual 8: So in closing... 

What is Hazus and why should you use it? 
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Visual 9: Questions 
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Handouts: Reference Materials 
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Handouts Outline 

The table below contains the type, number, and description of each handout. The data 
needed column identifies major datasets required to complete the activity. The data 
provided column identifies if that dataset is provided in the zip folder 
E0179_ActivityData for download. 

Type Number Description Data Needed Data Provided? 

Activity 2.1 Explore data 
available from 
various online 
sources 

None N/A 

Demonstration 2.2 Explore and 
review online 
GIS platforms 
for gathering 
data 

None N/A 

Exercise 3.1 Build a 
hurricane study 
region for 
Hurricane 
Harvey 

TX state 
dataset 

No 

Exercise 4.1 Run a Hurrevac 
scenario for 
Hurricane 
Harvey region 
using 
interactive 
Hurrevac 
download 

Hurrevac data No 

Exercise 5.1 Run a .dat 
scenario for 
Hurricane 
Harvey region 

.dat wind field Yes 

Exercise 5.2 Compare 
results of 
Hurrevac and 
.dat runs 

Results from 
previous 
activities 

No 



March 2019 E0179: Application of Hazus for Disaster Operations 

Handouts: Reference Materials  SM-350 

Type Number Description Data Needed Data Provided? 

Exercise 6.1 Export data in 
CDMS 

Utah state 
dataset 

No 

Exercise 6.2 Query and 
update data in 
CDMS 

Medical 
Facilities data 

Yes 

Demonstration 7.1 Explore tax 
assessor data 
for Salt Lake 
County 

None N/A 

Exercise 7.2 Import UDF 
data using 
CDMS 

Sample UDF 
data 

Yes 

Exercise 8.1 Import a depth 
grid and run 
analysis 

Depth grid Yes 

Exercise 9.1 Create a depth 
grid from 
DFIRM data 

DFIRM data Yes 

Exercise 10.1 Create a depth 
grid from HWM 
data 

HWM data Yes 

Demonstration 11.1 Review finding 
ShakeMaps 
from within 
Hazus 

None N/A 

Exercise 11.2 Run a source 
event 
earthquake 
scenario 

Data Map 
Attributes 

Yes 

Exercise 12.1 Run a 
ShakeMap 
scenario 

Data Map 
Attributes, 
ShakeMap 

Yes 
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Type Number Description Data Needed Data Provided? 

Exercise 13.1 Run a 
ShakeMap 
scenario with 
UDF 

ShakeMap grid 
XML 

Yes 

Exercise 14.1 Build a tsunami 
study region 

Oregon state 
dataset 

No 

Exercise 15.1 Run tsunami 
analysis and 
casualty 
analysis 

Sample data Yes 

Exercise 16.1 Run a 
combined 
earthquake and 
tsunami 
analysis 

Sample data Yes 

Activity 17.1 Export data as 
a shapefile and 
export an HPR 

Results from 
previous 
activities 

No 

Demonstration 17.2 Explore 
WinSCP and 
femadata 

None N/A 

Activity 17.3 Explore ArcGIS 
Online and 
create a map 

Results from 
previous 
activities 

No 

Activity 17.4 Create a static 
map 

Results from 
previous 
activities 

No 

 

Data Dictionary 

The table below contains the type, number, and data file name for each exercise. The 
data provided can be found in the zip folder E0179_ActivityData for download. 
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Type Number Data File(s) 
Provided 

Folder Location 

Exercise 5.1 Harvey_Windfield_
HazusReady.dat 

E0179_ActivityData 

Exercise 6.1 Utah_MedicalFaciliti
es.xls 

E0179_ActivityData 

Exercise 6.2 Utah_MedicalFaciliti
es_Edit.xls 

E0179_ActivityData 

Exercise 7.2 UDF_Sampled.xls E0179_ActivityData 

Exercise 8.1 dg_100 E0179_ActivityData\
SaltLake\DG 

Exercise 9.1 SLC_AOI; 
S_FLD_HAZ_AR;de
m_ft;S_BFE 

E0179_ActivityData\
SaltLake\DFIRM 

Exercise 10.1 SLC_AOI;dem_ft;SL
C_HWM 

E0179_ActivityData\
SaltLake\HWM 

Exercise 11.2 ModelBuilderShake
Map.mdb 

E0179_ActivityData 

Exercise 12.1 ModelBuilderShake
Map.mdb; 
ShakeMapMag5.xm
l 

E0179_ActivityData 

Exercise 13.1 grid_7.0Scenario.x
ml 

E0179_ActivityData 

Exercise 14.1 gar_maxR_ft;gar_d
em_ft 

E0179_ActivityData\
MSC_HazardSampl
eData\Garibaldi\Lev
el1.gdb 

Exercise 15.1 gar_dem_ft E0179_ActivityData\
MSC_HazardSampl
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Type Number Data File(s) 
Provided 

Folder Location 

eData\Garibaldi\Lev
el1.gdb 

Exercise 16.1 gar_maxR_ft;gar_d
em_ft 

E0179_ActivityData\
MSC_HazardSampl
eData\Garibaldi\Lev
el1.gdb 
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Activity 2.1 - Data Availability 

Type: Instructor-Led Activity  

Time: 10 minutes  

 Goal: Explore the data available through the United States Geological Survey (USGS), 
the National Hurricane Center (NHC), the Pacific Marine Environmental Laboratory 
(PMEL), and the Map Service Center (MSC).  

 Guide the class through the following websites to illustrate data availability for 
applications in disaster operations.  

 Go to the United States Geological Survey website https://www.usgs.gov/. The 
United States Geological Survey can supply data to Hazus for floods and 
earthquakes. 

 View the USGS Earthquake Data and Products website for data on earthquakes, 
https://earthquake.usgs.gov/data/.  

 NOTE: Hazus users are encouraged to use ShakeMap for 
earthquake runs in Hazus. ShakeMaps will be reviewed in detail 
later in the course.  

 Browse the data for a significant event and identify the files Hazus 
requires – PGA, PGV, Sa(0.3), and Sa(1.0).  

 View the National Water Information System website 
https://waterdata.usgs.gov/nwis for data on floods. Browse to a specific stream 
gauge and identify peak flow results.  

 Go to the National Hurricane Center website https://www.nhc.noaa.gov/. The 
National Hurricane Center is a part of the National Oceanic and Atmospheric 
Administration. 

 Click between the Pacific and Atlantic coasts to see how data is released 
separately for the different coasts. If there are storms available, click on them to 
receive additional, forecasted information. 

 Best Track Data or HURDAT, can be downloaded through the NHC data website 
https://www.nhc.noaa.gov/data/ and integrated into Hazus. HURDAT is a 
historical record for Pacific and Atlantic hurricane data. Click on the advisory 
archive and select a storm of interest. Click on a forecasted advisory and identify 
the storm location, pressure, size, and speed.  

 Go to the Pacific Marine Environmental Laboratory website 
https://www.pmel.noaa.gov/. The Pacific Marine Environmental Laboratory is a part 
of the National Oceanic and Atmospheric Administration (NOAA). 

 The PMEL data website https://www.pmel.noaa.gov/public/pmel/globe/ has 
options for a variety of hazards and environmental factors. Click on the NCTR 
box to see the areas where NOAA has researched tsunami propagation. The 
National Center for Tsunami Research https://nctr.pmel.noaa.gov/ provides 
additional information on tsunami forecasting and mapping.  

http://www.usgs.gov/
http://earthquake.usgs.gov/data/
http://www.nhc.noaa.gov/
http://www.nhc.noaa.gov/data
http://www.pmel.noaa.gov/
http://www.pmel.noaa.gov/public/pmel/globe
http://nctr.pmel.noaa.gov/
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 Go to the Map Service Center website https://msc.fema.gov/portal. The Map Service 
Center (MSC) is a part of the Federal Emergency Management Agency (FEMA). 

 The MSC publishes information through FEMA’s website 
https://www.fema.gov/national-flood-hazard-layer-nfhl on the National Flood 
Hazard Layer (NFHL). From here, click on the NFHL viewer link to view the data 
through the FEMA account on the ArcGIS Online website. 

 View the data products available by searching on all products and identifying a 
county. Discuss the GIS data available as well as the Flood Insurance Studies 
(FIS).  

 

http://msc.fema.gov/portal
http://www.fema.gov/national-flood-hazard-layer-nfhl
http://www.fema.gov/national-flood-hazard-layer-nfhl
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Exercise 3.1 - Hurricane Study Region 

Type: Student-Led Activity 

 Time: 10 minutes  

 Goal: Build a hurricane study region for Hurricane Harvey (2017).  

 

 Task  1: Create a New Study Region  

 Open Hazus from your desktop and select “Create a new region.” Click “OK.” 

 

 

 

 

 

 Click “Next” on the Create New Scenario Wizard.  
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 Enter a name and a brief description (optional) for your study region. Click “Next.” 
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 Select “Hurricane” as the Hazard type. Click “Next.” 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Handouts: Reference Materials  SM-359 

 

 

 

 When prompted to create the study region using the Hurricane Scenario Wizard, 
select “No.”  

 

 

 

 

 

 Task  2: Select Areas Affected by Hurricane Harvey  

 Select “County” as the aggregation level. Click “Next.” 
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 Select “Texas” from the list of states. Click “Next.”  
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 Select “Aransas” from the list of counties. Click “Next.”  
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 Click “Finish” to complete the Create New Region Wizard. 
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 A dialog box will appear (after a few minutes) indicating that the region was 
aggregated successfully. Click “OK.” 
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Exercise 4.1: Harvey Hurrevac Model 

Type: Student-Led Activity  

Time: 45 minutes  

Goals:  

 Run Model with Hurrevac.  

 Develop a map of your choice: the winds (by category), displaced population, 
economic loss, or tree debris.  

 View results.  

 Choose the same study region created in Exercise 3.1.  

Note: These instructions will guide making a map for building debris, but you can 
choose different results if you wish to create your map and view results. 

 

 Task  1: Open the Study Region 

This exercise will use the previously created study region for Aransas county in Texas.  

 Open Hazus and select “Open a region.”  

 

 

 

 

 

 Click “Next” on the Open Region Wizard.  
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 Select a study region to open. For this activity, select “HurricaneHarvey_CO” and 
click “Next.”  
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 Click “Finish” to complete the Open Region Wizard.  
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 Hazus will open in ArcMap (after a few minutes), displaying a map of Aransas 
county.  
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 Task  2: Create a New Scenario 

 In the top ribbon, navigate to “Hazard > Scenario.”  

 This prompts the Hurricane Scenario Management Window to open. Click “Next” on 
the welcome screen.  

 

 

 

 

 

 Select “Create a New Scenario.” Click “Next.”  
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 In the “User Defined Scenario Type” window, select “Import Hurrevac storm 
advisory.” Click “Next.” 
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 Click “Download” to download the storm from the HURREVAC ftp site.  
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 Highlight the “Atlantic” region, select “H” from the Storm Letter drop-down and 
“2017” for the year. Click “Download.”  

 

 

 

 

 

 Click “OK” when the data has successfully downloaded.  
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 Click “Close” to close the Hurrevac Download dialog box.  

 Click the refresh icon to refresh the list of storms with the downloaded data. Then 
select the “Atlantic” region to populate the list of storms.  

 

 

 

 

 

 Navigate to the Harvey 2017 storm and click on the row to highlight and select it. 
Click “Next.” 
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 Click “Next” on the Edit Storm Track window to continue. It will take a couple 
minutes to validate the storm track and perform calculations for the scenario. When 
the Windfield Calculation is complete, click “Next.”  

 Click “Next” on the Storm Track Data Review.  
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 Click “Next” on the Scenario Review. 
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 Select “Yes. Make this scenario active.” Click “Next.”  

 Click “Finish” to exit the Hurricane Scenario Management Wizard.  

 

 Task  3: Run the Analysis 

 Navigate to “Analysis > Run” to begin the damage and loss calculations for the 
Hurricane Harvey scenario.  

 Under “Automated Output Options” unselect “Create Maps,” then click “Run 
Analysis.” This will take a few minutes to complete.  

Note: The create maps option generates one or more standardized maps that 
you can define. This is a useful feature if you tend to create the same maps for 
your study region on a frequent basis. However, for this exercise that 
functionality serves no useful purpose.  
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 Click “OK” once the analysis has finished. 

 

 Task  4: View and Record the Results 

Note: These steps outline viewing and mapping Brick/Wood debris. You should develop 
a map of your choice: winds (by category), displaced population, economic loss, or tree 
debris.  

 Navigate to “Results > Debris.”  

 Click on the column “Brick/Wood (tons)” and then click “Map.” Then click “Close.”  
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 The census tracts that experienced losses from brick and wood debris will be 
categorically displayed on the map.  
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 Select the “Identify” tool.  

 

 

 

 

 

 Click on the highlighted census tract and record its “BRICKANDWOOD” value in the 
table at the end of this exercise.  
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 Click on the highlighted census tract and record its “BRICKANDWOOD” value. 
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 Click on the highlighted census tract and record its “BRICKANDWOOD” value. 
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  Enter the BRICKANDWOOD values in the table below. 

Census Tract Hurrevac 

48007950100  
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Census Tract Hurrevac 

48007950500  

48007950300  

 Save your map document and close the scenario.  
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Exercise 5.1: Harvey .dat Model 

Type: Student-Led Activity  

Time: 45 minutes  

Goals:  

 Run Model with .dat data.  

 Develop a map of the winds (by category), displaced population, economic loss, or 
tree debris.  

 View Results.  

 Choose the same study region you created in Exercise 3.1.  

 

 Task  1: Open the Study Region 

 Open Hazus and select “Open a region.” We will open the previously created study 
region for Aransas county in Texas.  

 Click “Next” on the Open Region Wizard.  

 Select the study region you wish to open. For this activity, open 
“HurricaneHarvey_CO.”  
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 Click “Finish” to complete the Open Region Wizard.  

 

 

 

 

 

 After a few minutes, Hazus will open in ArcMap displaying a map of Aransas county.  
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 Task  2: Create a New Scenario 

 In the top ribbon, navigate to “Hazard > Scenario.” This prompts the Hurricane 
Management Window to open.  

 Click “Next” on the welcome screen.  
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 Select “Create a New Scenario.” Click “Next.”  
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 In the User Defined Scenario Type, select “Import Census Tract Data file (e.g. 
H*Wind).” Click “Next.” 
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 Enter a name for the new scenario. 
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 Click “Browse” to navigate to and select the “Harvey_Windfield_HazusReady.dat” 
file saved on the computer. Click “Next.” 
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 Click “Next” on the Storm Track Data Review. 
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 Click “Next” on the Scenario Review.  

 Select “Yes. Make this scenario active.” Click “Next.”  
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 Click “Finish” to exit the Hurricane Scenario Management Wizard.   

 

 Task  3: Run the Analysis 

 Navigate to “Analysis > Run” to begin the damage and loss calculations for the 
Hurricane Harvey scenario.  

 Under Automated Output Options unselect “Create Maps,” then click “Run Analysis.” 
This will take a few minutes to complete.  

Note: The create maps option generates one or more standardized maps that 
you can define. This is a useful feature if you tend to create the same maps for 
your study region on a frequent basis. However, for this exercise that 
functionality serves no useful purpose.  
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 Once the analysis is complete, click “OK”.   

 

Task 4: View and Record the Results 

 Navigate to “Results > Debris.”  

 Click on the column for “Brick/Wood (tons)” and then click “Map.”  
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 The census tracts that experienced losses from brick and wood debris will be 
categorically displayed on the map.  
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 Select the “Identify” tool.  

 

 

 

 

 

 Click on the highlighted census tract and record its “BRICKANDWOOD” value.  
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 Click on the highlighted census tract and records its “BRICKANDWOOD” value. 
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 Click on the highlighted census tract and records its “BRICKANDWOOD” value. 
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 Save your map document and close the scenario.  

 

 Enter the BRICKANDWOOD values in the table below. 

Census Tract .dat 
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Census Tract .dat 

48007950100  

48007950500  

48007950300  

 Save your map document and close the scenario.  
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Exercise 5.2: Compare the Outputs 

Type: Student-Led Activity  

 Time: 15 minutes  

 Goal: Compare the Hurrevac and .dat results for Hurricane Harvey.  

Background: As a disaster operations manager, you may be responsible for assessing 
damages both as a planning measure and during recovery efforts. As you move through 
this exercise, consider how you would use this information during various operational 
phases. For example, if preparing a report on damages and resources needed to 
rebuild a community, what data source and results type would you want to use?  

 

Task 1: View the Results from the Hurrevac Output (previous 
lesson) 

 Open the map document and refer to the debris damages noted earlier in the 
previous lesson (Exercise 4.1). 

 

 

 

 

 

Task 2: View the Results from the .dat Output (earlier this lesson) 

 Open the map document and refer to the debris damages noted earlier in this lesson 
(Exercise 5.1). 
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Task 3: Compare the Results and Identify Differences 

 Identify differences in values, range, distribution, display, or other aspects of the 
maps and data. 

Census Tract Hurrevac .dat 

   

   

   

You can populate this table based on the results from Exercises 4.1 and 5.1. 

 

Results Questions 

1. What differences do you observe between the results from Hurrevac and the results 
from .dat? 

2. What is the Hurrevac data based upon? 
3. What is the .dat data based upon? 
4. What could be the reason behind the differences in the results?  
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Exercise 6.1: GBS (General Building Stock) Data 

Type: Student-Led Activity  

Time: 15 minutes  

Goal: Identify and export data from a state dataset.  

 Background: This document describes how to use CDMS (Comprehensive Data 
Management System) to export data from a Statewide database to manipulate.  

 

 Task  1:  Open CDMS and Change State Databases  

 Open CDMS. 

 

 

 

 

 

 Navigate to “Tools > Specify Hazus-MH Data Location.”  

 The CDMS Statewide DB Configuration window will appear. Click “Browse” and 
navigate to C:\HazusData\Inventory\UT\. 
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 Select “UT” and click “OK.” 
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 Click “OK” and the current state will be changed to Utah.  
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 Task  2: Query County for Specific Buildings 

 From the main CDMS page, click “Query/Export Statewide Datasets.” Click the drop-
down under “Search By Geographic Area” and select “County.” 
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 A list of counties will appear in the box. 

 For this exercise, we will be reviewing hospitals in Salt Lake City. Select “Salt Lake” 
as your county and move it over to the “Selected Geographical Areas” using the right 
arrow.  
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 Select “Essential Facilities,” in the Filter By Data Category drop-down menu. Click 
on “Medical Care Facilities” and use the right arrow to move it over to Selected Data 
Layers.  

Note: This drop-down can be used to filter through the various categories. If you 
do not want to filter, you can always simply scroll and select the desired data 
categories.  
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 Check off the hazards you wish to pull data for. For this exercise, check both 
“Earthquake” and “Flood.”  

 Click “Search.” Depending on how many items CDMS has to pull, this can take a few 
minutes. For this exercise, it should take less than a minute.  

 

 Task  3: Export Query to Excel 

 The screen now displays all the Medical Care Facilities within Salt Lake County. 
They are organized by their HazusID. Select “Export to Excel.”  

Note: If you wanted to make changes to the medical facilities, you would want to 
first back up your state database (found in //HazusData/Inventory).  

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Handouts: Reference Materials  SM-416 

 

 

 

 Select “Export currently selected layer,” and click “Submit.” 

 

 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Handouts: Reference Materials  SM-417 

 

 Name and save the exported file “Utah_MedicalFacilities.xls” in the Downloads 
folder. If a Downloads folder doesn’t exist, create one. 

 Navigate to the location of the exported file and open it. You will see that the first row 
contains the various parameters Hazus uses for buildings. These are the fields 
Hazus can accept in order to add Medical Facilities to a database. Not all of these 
fields are required. 

Note: This represents the Hazus format of how Hazus looks at data. In 
subsequent exercises, we will go through how to add/update data for a Hazus 
database to use.  

 

 

 

 

 

 Keep CDMS open for the next activity.   
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Exercise 6.2: Site-Specific Data 

Type: Student-Led Activity  

Time: 30 minutes  

Goal: Use CDMS to update existing inventory.  

 Background: This document describes how to use CDMS (Comprehensive Data 
Management System) to import data into a statewide database. For this exercise, you 
will use the data you exported from the last activity. If you were unable to complete the 
last activity, use the provided Utah_MedicalFacilities.xls file. Before beginning this 
exercise, it is recommended to back-up your Utah state database as this exercise may 
alter previous changes. In general, when making major updates and changes to a 
statewide dataset, it is a good idea to back up your latest working version.  

 

 Task  1: Query Hospitals in Salt Lake and Delete Existing 
Inventory  

 This screen displays all the Medical Care Facilities within Salt Lake County 
organized by their HazusID. 
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 In the previous exercise, this information was exported. For the purpose of this 
exercise, click on the first entry, hit “Ctrl + A” on your keyboard to select all entries, 
and then click “Delete All Records for Selected Inventory.” Click “Yes” when asked to 
confirm deletion. 

 

 

 

 

 

 You should now see zero entries for Medical Facilities. When updating data points 
for facilities, it is necessary to delete the previous entry. This ensures all the fields 
for that building are overwritten. In this case, all new entries will be added because 
the entire county is being updated.  

 Open the Utah_MedicalFacilities.xls file from the last activity.  

 Delete the first column, HazusID.  

 Save the new file as Utah_MedicalFacilities_Edit.xls  
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 Task  2: Import Medical Facilities Dataset into CDMS 

 Click “CDMS Home.”  

 Select “Import into CDMS Repository from File.”  

 In the Select a file for Import dialogue, click “Browse” and change the file type to 
“Microsoft Excel (*.xls).” Navigate to the Utah_MedicalFacilities_Edit file in the 
downloads folder and click “Open.”  

 For “Specify hazards importing data for”, select “Earthquake” and “Flood.” 

 For Select Inventory Category, select “Essential Facilities.” 

 For Select Inventory Dataset (Layer), select “Medical Care Facilities.” Click 
“Continue.” 

 

 

 

 

 

 Leave “Select Import Table” as the default.  

 Change “Select HAZUS-ID Field” drop-down to “No HAZUS ID”. 

 For the “Latitude” drop-down, select “Latitude” and for the “Longitude” drop-down, 
select “Longitude.”  
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 Click “Continue.” 

 

 Task  3: Match Source and Destination Fields 

 This screen will display data field matching. In a real situation, it would take effort to 
prepare the data to make sure it is compatible with what Hazus is looking for.  

 Click “Add” from the “Source Fields” and make sure “Address” is selected from the 
Destination Fields. Then click “Add Match.” 
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 Continue matching for the following items until you have one entry remaining in the 
“Source Fields” (EQ Deep Foundation Type) and one entry in the “Destination 
Fields.” (Flood Structure Foundation Type), which do not match. CDMS should 
match most of the Source and Destination columns naturally because it looks for 
similar naming conventions, however, it may miss some.  

 Click “Continue.” A window will appear to inform you that default values will be put in 
for those where no matches were provided. Click “Yes.”  

 CDMS will now ask you to categorize specific data. Click “OK.” 
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 On the next few screens, you will need to verify that the entry in Matching Results 
matches with an entry in the Destination box. For this exercise, they should all match 
up. In a real situation, there may be instances where you have to match the value in 
the Source field with the Destination field. Click “Continue” as they match up.  

 CDMS will now process the information. This will take approximately one minute. 
Once the data is imported, a window will appear signifying the import was 
successful. Click “OK.” Maintaining the most accurate data possible in CDMS will 
improve the accuracy of damage estimates and other Hazus results. When 
identifying medical facilities, for example, accurate building data may assist in 
identifying the hospitals that are still functional after a hazard strikes an area. The 
identification of functional and damage hospitals can support resource allocation, 
evacuation route planning, movement of at-risk populations, and other recovery 
efforts.  

 

 Task  4: Update State Database and Query for Confirmation  

 Click “Transfer to Statewide Dataset.” 
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 A Statewide Data Transfer Options window will appear. Since we already deleted 
previous entries, select “Append/Update Data.”  

 

 

 

 

 

 You will be asked to confirm this action. Click “Yes.” This will take a few minutes to 
process.  
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 Once CDMS has added the new data to your Utah dataset, run the query exercise 
again to confirm the Medical Facilities have been added.  
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Exercise 7.2: User-Defined Facilities (UDF) 

Database 

Type: Student-Led Activity  

Time: 20 minutes  

Goal: Load UDF into Hazus through CDMS.  

 Background: This document describes how to use CDMS (Comprehensive Data 
Management System) to add a dataset of User Defined Facilities (UDFs) to the Salt 
Lake City study region. You may need to extract the data found in the Activities data 
folder.  

 Note: Once you change a State Database you must create a new study region with the 
updated State Database. Old study regions are not updated with new inventory 
information from the state database after they are first formed.  

 

 Task  1: Open CDMS and confirm or change State Databases  

 Open CDMS. If the current state database is Utah (from previous exercises) you can 
skip to Task 2. 
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 Go to “Tools > Specify Hazus-MH Data Location.” 

 The CDMS Statewide DB Configuration window will appear.  

 

 

 

 

 

 Click “Browse” and navigate to C:\HazusData\Inventory\UT\.   
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 Select UT and click “OK.” Click “OK” again and the current state will be changed to 
Utah.  
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 Task  2: Import the UDF data with CDMS and Set Import 
Parameters  

 Click “Import into CDMS Repository from File.” 
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 Click “Browse” and navigate to the Activities folder.  

 Change the file type to find “Microsoft Excel File (*.xls).”  

 Choose “UDF_Sampled.xls.” 

 For “Specify hazard importing data for”, select “Earthquake” and “Flood.”  

 Select “User Defined Facilities” from the drop-down menu for both Select Hazus 
Inventory Category and Select Hazus Inventory Dataset (Layer).  
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 Click “Continue.” 

 “Sheet1” will be selected for the import table automatically.  

 It is the only sheet in the workbook.  

 If there were multiple sheets, the user would have to choose the table they 
wanted to import into CDMS.  

 Select “No HAZUS ID” from the Select HAZUS ID Field ** (if available) drop-down 
menu.  

 Select “Cent_lat” from the Select Latitude (Y) Field drop-down menu.  

 Select “Cent_long” from the Select Longitude (X) Field drop-down menu.  
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 Click “Continue.” 

 

 Task  3: Complete Data Field Mapping  

 Data Field Matching has already been done for you.  

 If needed, you can do it manually by selecting the source field, the destination 
field, and clicking “Add Match.”  

 Click “Load.”  
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 Browse to the Activities folder and select the “UDF_Field_Mapping.fmp” file. Click 
“Open.” 
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 The fields will automatically be mapped. 
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 Click “Continue.” 

 CDMS will ask if the Hazus defaults are ok for the rest of the fields. Click “Yes”  

 CDMS will ask you to categorize the “Earthquake Design Level.” Click “OK.”  
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 All the values have been properly mapped. Click “Continue.” 
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 CDMS will now run this request. This will take approximately 3 to 4 minutes. When 
the confirmation box appears, click “OK.” 

 

 Task  4: View Table and Import into State Geodatabase 

 Click “View/Edit.” 
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 A UDF table will appear that will be used by Hazus. Explore it at your leisure. 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Handouts: Reference Materials  SM-439 

 

 

 

 Click “Close.”  

 Click “Transfer to Statewide Dataset.”  
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 Click “Append/Update Data” and then “Submit.” 

 

 CDMS will ask for confirmation. Click “Yes.” This will take about 1 minute. 

 The window will then show that the UDF dataset has been moved to the State 
database folder. 
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Exercise 8.1: Depth Grid 

Type: Student-Led Activity  

Time: 25 minutes  

Goal: Import a 100-year depth grid.  

File Preparation: 

 You should have Utah state data already on your computer. If not, download the 
“Utah” State Folder from https://msc.fema.gov/portal/resources/hazus 

 Move the file to the “\HazusData\Inventory\” folder and unzip the folder onto the hard 
drive of the computer on which the analysis is being conducted (for this example, 
C:\HazusData\Inventory).  

 To unzip the folder, double-click the UT file and it will extract itself to the correct 
location.  

 Your instructor will provide data in the Activities folder. Unzip the SaltLake.zip folder 
so you can access it throughout the exercise. 

 Place this folder in the “\HazusData\Regions\” on the hard drive of the computer.  

 

Task 1: Create a New Salt Lake City Study Region  

 Open Hazus 4.2.  

 Click “Create a new study region” and “OK.”  

 The Create New Region window will appear. Click “Next.”  

 Name the study region “Salt_Lake_City_FL” and enter a brief description, such as 
“DFIRM exercise for Salt Lake City flooding.”  

 Click “Next.”   
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 Check the box “Flood” and click “Next.”  

 Click “County” and then “Next.”  

 Select “Utah” and click “Next.”  
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 Select “Salt Lake” County and click “Next.” 
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 Click “Finish.” 

 

 Task 2: Open Salt Lake City Study Region  

 Click “Open a region” and then “OK.” The Open Region window will appear.  

 Click “Next.”  

 Select “Salt_Lake_City_FL” and click “Next.”  

 Click “Finish.” ArcMap will open your Salt Lake City region.  
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 Task 3: Use the Hazus Interface to Define a DFIRM 

 Click “Hazard > Flood Hazard Type…,” located in the top ribbon.  

 Select “Riverine Only” and click “OK.”  

 

 

 

 

 

 Click “Hazard > User Data” in the top ribbon.  

 Navigate to the “Depth Grid” tab and click “Browse…”  
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 Browse to the provided data located in the Regions folder and select “dg_100.” Click 
“Select.” 
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 Click “Set Parameters.” 
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 Input a Return Period of “100” and click “OK.” 
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 Click “OK” again and a progress bar will appear. 
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 Navigate to “Hazard > Scenario > New…,” located in the top ribbon.  

 Name the scenario “DG_100” and enter a brief description “100 year depth grid.”  
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 Click “OK” and the outline of the depth grid will appear on the map with the layer 
Depth Grid in the table of contents. 

 Click the plus button next to “Add to selection” and draw a box around one of the 
outlined areas. 
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 The depth grid outline will be highlighted. Click the save button next to “Save 
selection.” 
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 The selection will change to a dark blue and a “DGRiv” layer will appear in the table 
of contents. 
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 Click “OK.”  

 Navigate to “Hazard > Riverine > Delineate Floodplain,” located in the top ribbon.  

 Click “OK”  
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 Click “Yes” to indicate that raster processing may occur.  

 The user cannot stop this process once it starts.  

 This will take approximately 1 minute.  

 Click “OK” on the successful run time window. A “RPD100_r” and a 
“BoundaryPolygon” layer will appear in the table of contents and the map will 
update. 

 

 

 

 

 

 Navigate to “Analysis > Run,” located in the top ribbon.  

 Click “Select All” and deselect “Agricultural Products” and “What-if” in the Analysis 
Options window.  
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 Click “OK.” This will run for about 15 minutes.  

 Click “OK” on the successful run time window.  

 

  Task 4: View Results 

 Navigate to "Results > View Current Scenario Results By..." 

 Click “OK” to view the 100 year return period results. 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Handouts: Reference Materials  SM-458 

 

 

 

 Navigate to “Results > User-Defined Facilities.”  

 Click a column header and click “Map.” We will have to specifically select symbology 
to map a particular field.  
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 Click “Close” and notice the green boxes that appeared on the map. 
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 Use the zoom button to zoom into the green boxes.  

 Note: The dasymetric census blocks will appear when zoomed in.  

 Right-click on the “User-Defined Facilities Layer” in the table of contents and go to 
Properties. 

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Handouts: Reference Materials  SM-461 

 

 

 

 In the symbology tab, locate “Quantities” on the left.  

 Click the “Value” drop-down menu and select “BldgDmgPct." 
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 Change the symbol properties, making all the symbols size 10, for ease of viewing. 
Click “OK.” 
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 Click “OK.“ The markers are now colored by damage percent.  
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 Take a minute to explore the mapped facilities and identify parts of the study region 
that may require targeted response activities. This identification and staging area 
location is an important part of response planning. Think about what other 
information you might need to develop and to conduct disaster operations 
management given this scenario. Discuss with your neighbors what additional data 
would be helpful and if Hazus may have it.  

 Navigate to “Results > General Building Stock > Economic Loss > By Full 
Replacement.”  

 Click the “Total” tab. Change the drop down from “Pre-Firm” to “Total”. Click the 
“TotalLoss” header and then “Map.”  
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 Click “Close.” 
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Exercise 9.1: DFIRM (Digital Flood Insurance 

Rate Map) Depth  

 Type: Student-Led Activity  

Time: 30 minutes  

Goal:  

 Create a depth grid based off a DFIRM dataset and the Esri ArcMap Spatial Analyst 
toolset.  

 Keep track of the name of the files generated.  

 Background: The purpose of this activity is to demonstrate the geoprocessing steps to 
create a depth grid (DG) utilizing DFIRM data and the Esri ArcMap spatial analyst 
toolset. DFIRM is often the only source of depth data available for communities, so 
understanding this process is crucial for being able to use Hazus in disaster operations 
around flooding hazards. 

 Required Geographic Data:  

 Digital Flood Insurance Rate Map (DFIRM)  

 DFIRM: digital version of a Flood Insurance Rate Map (FIRM)  
 Shows a community’s base flood elevations, flood zones, and 

floodplain boundaries for the 1% and 0.2% annual chance flood 
hazard zones  

 All data used to produce the FIRM are stored in the DFIRM 
Database.  

 A portion of the DFIRM Database is packaged as the National 
Flood Hazard Layer (NFHL); available from the FEMA Map Service 
Center (MSC) (http://msc.fema.gov/portal).  

 For this activity, we will be using several features found in the 
DFIRM Database for Salt Lake County, UT (NFHL_49035C; Last 
Study Effective Date: 08/02/2012).  

 Terrain Data (DEM)  

 For this activity, we will be using 1/3 arc second DEM.  
 Time and level of analysis detail are prime factors in determining 

the resolution of terrain data to be used in your analysis.  

 Area of Interest (AOI)  

 To ensure everyone is able to complete the exercise in a 
reasonable time frame, an Area of Interest (AOI) polygon has been 
provided.  

 This file is named SLC_AOI and is stored in the DFIRM folder in the 
SaltLake folder used in the last exercise.  

 Note: Only the major steps have been provided. Be sure to keep track of the name of 
the files that you generate.  

http://msc.fema.gov/portal


March 2019 E0179: Application of Hazus for Disaster Operations 

Handouts: Reference Materials  SM-469 

 

Task 1: Prepare the Data in ArcMap  

 Open ArcMap and start a new map. 

 In your new Blank Map add the “SLC_AOI” feature class from the SaltLake\DFIRM\ 
folder. This file represents your area of interest. 

 In your new Blank Map add the “S_FLD_HAZ_AR” feature class from the 
SaltLake\DFIRM\ folder. You may receive a Geographic Coordinate Systems 
Warning. Click “Close.” This file represents your special flood hazard area. 

 Add the “dem_ft” dataset from the SaltLake\DFIRM\ folder. This file represents your 
digital elevation model. 

 Using the Data Management tools in the Projections and Transformations Toolbox, 
project the S_FLD_HAZ_AR feature class to WGS_1984.  
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 Set the following parameters:  

 Input Dataset: S_FLD_HAZ_AR  

 Output Dataset: HAZ_WGS SaltLake\DFIRM\DFIRMOutput\ folder  

 Output Coordinate System: WGS 1984  

 

 

 

 

 

 Click “OK.”  

 Remove the “S_FLD_HAZ_AR” layer or turn it off.  

 From the Geoprocessing menu, choose “Clip.” Set the following parameters.  

 Input Features: HAZ_WGS  

 Clip Features: SLC_AOI  

 Name the output “SFHA_Clip.”  
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 Save it to the SaltLake\DFIRM\DFIRMOutput\ folder.   

 

 

 

 

 

 Click “OK.”  

 Remove the “HAZ_WGS” layer or turn it off.  

 From the File Menu choose “Selection > Select by Attributes.”  

 Choose “SFHA_Clip” as the Layer.  

 Type one of the following in the Query text box toward the bottom of the window. 
This query includes all flooding A-zones. 

 "FLD_ZONE" = 'A'  
 "FLD_ZONE" = 'AE'  
 "FLD_ZONE" = 'AH’ 
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 Click “OK.”  

 Right-click on the “SFHA_Clip” layer and choose “Data > Export Data.”  

 Save the selected features to a new feature class named “A_Zone” in the 
SaltLake\DFIRM\DFIRMOutput\ folder.  
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 Click “OK.”  

 Select “Yes” to add the layer to the map.  

 From the Geoprocessing menu choose “Dissolve.”  

 Choose “A_Zone” as the Input Features.  

 Name the Output Feature Class “Inundation_Boundary” in the 
SaltLake\DFIRM\DFIRMOutput\ folder.  
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 Be sure “Create multipart features” is checked. Click “OK.”  

 Remove or turn off the “A_Zone” and “SFHA_Clip” Layers.  

 Add the “S_BFE” shapefile in the the SaltLake\DFIRM\DFIRMOutput\ folder to the 
map. This file contains the cross sections. You may receive a Geographic 
Coordinate Systems Warning. Click “Close.”  

 Using the Data Management tools in the Projections and Transformations Toolbox, 
project the “S_BFE” feature class to WGS_1984.  

 Input Dataset: S_BFE  

 Output Dataset: S_BFE_WGS in \SaltLake\DFIRM\DFIRMOutput\ folder 

 Output Coordinate System: WGS 1984  
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 Click “OK.”  

 Turn off or remove the “S_BFE layer.”  

 From the Geoprocessing menu choose “Clip.” Set the following parameters.  

 Input Features: S_BFE_WGS  

 Clip Features: Inundation_Boundary  

 Name the new feature class “BFE_A_Clip”  

 Save it in the FL_Exercises\SaltLake\DFIRM\DFIRMOutput\ folder.  
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 Click “OK.”  

 Turn off or remove the “S_BFE_WGS layer.”  

 In ArcToolbox open the “Feature Vertices to Points” tool located in the “Data 
Management Tools > Features” folder.  

 Set the Input features to “BFE_A_Clip.”  

 Save the output feature class as “BFE_A_Points” in the 
FL_Exercises\SaltLake\DFIRM\DFIRMOutput\ folder.  

 Click “OK.”  
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 Task  2: Interpolate the Water Surface  

 In ArcToolbox open the IDW tool found under the “Spatial Analyst Tools > 
Interpolation” folder. Set the following parameters:  

 Input point features: BFE_A_Points  

 Z value field: ELEV  

 Output raster: “A_Water_Surf” in the SaltLake\DFIRM\DFIRMOutput\ folder.  

 Output cell size: 2.56249520289145E-05.  
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 Click “Environments.”  

 From the Processing Extent area under the “Extent” drop-down menu, choose 
“Same as layer SLC_AOI.” The fields should read as:  

 Top: 40.804658  
 Right: -111.874235  
 Bottom: 40.675088  
 Left: -111.974413  

 From the Raster Analysis area under the “Mask” drop-down menu, choose 
“SLC_AOI.” Click “OK.” 3. Click “OK” to create the A Water Surface.  

 

 Task  3: Prepare the Depth Grid  

 In ArcToolbox, open the “Spatial Analyst Tools > Math” toolbox.  

 Double-click the Minus tool and fill in the parameters as shown below to subtract the 
water surface from the ground surface.  

 Input raster or constant value 1: A_Water_Surf  

 Input raster or constant value 2: dem_ft  

 Output raster = IDW_Minus_DEM in the DFIRMOutput folder.  
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 By subtracting the water surface from the DEM you will get those areas where 
the water is at a higher elevation than the ground or, more specifically, the depth 
of water.  

 

 

 

 

 

 Click “OK” to complete the process. The new layer should appear as follows. 
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 In ArcToolbox, open the “Spatial Analyst Tools > Extraction” toolbox.  

 Open the “Extract by Attributes” tool. Set the following parameters:  
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 Input Raster: IDW_Minus_DEM.  

 Where clause: Value > 0  

 Save the output raster as Non_Zero in the DFIRMOutput folder.  

 When subtracting the water surface from the DEM there are places where the 
DEM is at a greater elevation than the water surface, indicating there is no water 
depth. Removing the negative values leaves only the depth of flooding.  

 

 

 

 

 

 Click “OK.”  

 From the Spatial Analyst Toolbox choose “Extraction > Extract by Mask.” Set the 
following parameters:  

 Input Raster: Non_Zero  

 Feature mask data: Inundation Boundary (from earlier in the exercise)  

 Save the output raster as Depth_Grid in the DFIRMOutput\ folder.  
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 Click “OK.”  

Note: When your Depth Grid has finished, the grid and boundary (Inundation Boundary) 
should look similar to the following image. You may have to re-arrange or turn off layers 
to view the new dataset.  
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 Task  4: Understand the DFIRM Database 

 The National Flood Hazard Layer (NFHL) data incorporates all Flood Insurance Rate 
Map (FIRM) databases published by the Federal Emergency Management Agency 
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(FEMA), and any Letters of Map Revision (LOMRs) that have been issued against 
those databases since their publication date. It is updated on a monthly basis. The 
FIRM Database is the digital, geospatial version of the flood hazard information 
shown on the published paper FIRMs. 

 The FIRM Database depicts flood risk information and supporting data used to 
develop the risk data. The primary risk classifications used are the 1-percent-annual-
chance flood event, the 0.2-percent-annual-chance flood event, and areas of 
minimal flood risk. The FIRM Database is derived from Flood Insurance Studies 
(FISs), previously published FIRMs, flood hazard analyses performed in support of 
the FISs and FIRMs, and new mapping data, where available. The FISs and FIRMs 
are published by FEMA. 

 The NFHL is available as State or US Territory data sets. Each State or Territory 
data set consists of all FIRM Databases and corresponding LOMRs available on the 
publication date of the data set.  

 The specification for the horizontal control of FIRM Databases is consistent with 
those required for mapping at a scale of 1:12,000. This file is georeferenced to the 
earth's surface using the Geographic Coordinate System (GCS) and North American 
Datum of 1983.  

 Data included (bold features are the most often used for depth grid creation):  

 L_COMM_INFO.dbf: Information about each community on the FIRM.  

 L_SOURCE_CIT.dbf: Listing and description of the sources of information used 
in the FIRM or referenced in the FIS report bibliography.  

 L_XS_ELEV.dbf: Information about the hydrologic model at each mapped cross 
section and those cross sections referenced in the FIS report Floodway Data 
Tables. This table is used to generate the Floodway Data Tables and contains 
lettered cross sections.  

 S_BFE: Shapefile with the location and attributes for Base Flood Elevations 
(BFEs) shown on FIRM.  

 S_FIRM_PAN: Shapefile with location and attributes for FIRM hardcopy map 
panels.  

 S_FLD_HAZ_AR: Shapefile with the location and attributes for flood insurance 
risk zones on the FIRM.  

 S_FLD_HAZ_LN: Shapefile with the location and attributes for the boundaries of 
flood insurance risk zone on the FIRM. 

 S_GEN_STRUCT: Shapefile with the location and attributes for flood control 
structures shown on the flood profile and FIRM.  

 S_LEVEE: Shapefile with the location of levee centerlines, floodwalls, and 
closure structures protecting accredited and provisionally accredited levees.  

 S_LOMR: Shapefile with the location and attributes for Letter of Map Revisions 
(LOMRs) not yet incorporated on the FIRM. Used only as part of the national 
Flood Hazard Layer (NFHL).  

 S_PLSS_AR: Shapefile with the location and attributes of sections, townships, 
and ranges on the FIRM  

 S_POL_AR: Shapefile with the location and attributes for political jurisdictions 
shown on the FIRM.  
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 S_PROFIL_BASLN: Shapefile with the location and attributes for profile baseline 
and stream centerline features for the flood risk project area.  

 S_WTR_LN: Shapefile with the location and attributes for hydrography features 
shown on FIRM as lines  

 S_XS: Shapefile with the location and attributes for cross section lines in the area 
covered by the FIRM. This layer must contain all cross sections in a model, not 
just the lettered cross sections.  

 STUDY_INFO.dfb: General information about the FRIM  
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Exercise 10.1 - High Water Marks (HWM) Depth 

Grid 

Type: Student-Led Activity  

Time: 30 minutes  

Goal: Create a high water mark depth grid.  

 Background: There are a variety of tools and resources from which you might acquire 
depth grids. The availability of data, along with your skills as a GIS analyst, will 
determine how effectively you can use these resources. This activity demonstrates one 
process for creating a Hazus compliant depth grid using field collected and verified High 
Water Marks (HWM) and the Esri ArcMap Spatial Analyst toolset. FEMA recently 
laughed the High Water Mark (HWM) Initiative, which is a community-based awareness 
program that increases local communities' awareness of flood risk and encourages 
action to mitigate that risk. HWM signs may be posted in prominent places to encourage 
greater understanding of how floods may affect communities and provide greater 
awareness of how that data can be used to complete mitigation actions and build 
resilience against future flooding.  

A few data considerations to keep in mind while working through the geoprocessing 
steps to creating a depth grid:  

 Make sure that all of your data conforms to the same projection. If requisite datasets 
are projected differently, you will encounter errors in your geoprocessing procedure. 
It is recommended that all datasets be projected into World Geodetic System 1984 
(WGS 84). 

 What vertical units is your terrain data displayed (Feet, Meters, etc.)?  

 If the terrain data is in meters, use the Raster Calculator to convert the terrain 
dataset to feet if the intention is to use the final depth grid in Hazus.  

 What vertical datum are the HWM’s (NAVD88, NGVD29, etc.)?  

 The vertical datum of your terrain data and HWM data need to match. Most data 
will be delivered in NAVD88. In the rare case HWM data is collected and 
delivered in NGVD29, you will need to convert the data. You can use the 
VDATUM converter or another tool of your choice for this purpose.  

 Required Geographic Data  

 High Water Marks (HWM):  

 Point data collected using high resolution GPS systems. HWM points represent 
the highest extent of riverine flood or coastal storm surge inundation. These 
points are used as the foundation for interpolating maximum flood or surge extent 
for the final processed Depth Grid.  

 For this activity, an example of HWM in Salt Lake City (SLC), Utah, will be used. 
This data is stored as a feature class named SLC_HWM. You can review the 
dataset at SaltLake\HWM\.  
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 Terrain Data:  

 Can be acquired from many sources. The most common venue for obtaining 
elevation datasets is through the USGS National Map Viewer. The National 
Elevation Dataset (NED) is available nationally at resolutions of 1 arc-second 
(about 30 meters), 1/3 arc second (about 10 meters), and in 1/9 arc-second 
(about 3 meters).  

 In addition, high resolution LiDAR (Light Detection and Ranging) data terrain data 
(1-3 meter resolution) may be available through local municipalities within your 
project area. The US Interagency Elevation Inventory is good source of 
information on local LiDAR collections.  

 For this exercise, 1/3 arc second NED will be used. Time and level of analysis 
detail are prime factors in determining the resolution of terrain data to be used in 
your analysis. The raster dataset, “dem_ft”, is saved as a Grid.  

 

Task  1: Interpolate the Water Surface and Create Depth Grid  

 Start ArcMap.  

Note: Verify that the Spatial Analyst Extension is activated. You will need tools in 
this activity that are provided as part of this extension.  

 Add the following shapefiles to your map. All data is found in the \SaltLake\HWM\ 
folder.  

 SLC_AOI  

 dem_ft  

 SLC_HWM (You may receive a Geographic Coordinate Systems Warning. Click 
“Close.”)  

 Project the Salt Lake City High Water Marks.  

 In ArcToolbox open the Data Management Tools > Projections and Transformations 
folder.  

 Open the Project tool.  

 Complete the Project tool parameters as shown below:  

 Input point features: SLC_HWM  

 Output raster: \SaltLake\HWM\HWMOutput\HWM_WGS  

 Output Coordinate System: WGS 1984  
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 Click “OK.” 
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 In ArcToolbox open the Spatial Analyst Tools > Interpolation folder.  

 Open the Inverse Distance Weighted (IDW) tool.  

 Complete the IDW tool parameters as shown below:  
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 Input point features: HWM_WGS  

 Z value field: ELEV  

 Output raster: \SaltLake\HWM\HWMOutput\HWM_IDW  

 Output cell size: 1.59603760863234E-05  

 

 

 

 

 

 Click “Environments.”  

 From the Processing Extent area under the “Extent” drop-down menu, choose 
“Same as layer SLC_AOI.”  

 From the Raster Analysis area under the “Mask” drop-down menu, choose 
“SLC_AOI.” Click “OK.” 
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 Click “OK” to complete the process. This will take approximately 3 minutes to 
complete. 

 

Task  2: Subtract Water Surface Grid from the DEM 

 In ArcToolbox, open the Spatial Analyst Tools > Math folder.  
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 Double-click the Minus tool and fill in the parameters as shown below to subtract the 
water surface from the ground surface.  

 Input raster or constant value 1: HWM_IDW  

 Input raster or constant value 2: dem_ft  

 Output raster: \SaltLake\HWM\HWMOutput\ IDW_Minus_DEM  

 By subtracting the water surface from the DEM, you will get the areas where the 
water is at a higher elevation than the ground or, more specifically, the depth of 
water.  

 

 

 

 

 

  Click “OK” to complete the process. The new layer should appear as shown below: 
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Task  3: Remove Negative Values 

 In ArcToolbox, open the Spatial Analyst Tools > Extraction folder.  
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 Open the Extract by Attributes tool.  

 Fill in the parameters as shown:  

 Input Raster: IDW_Minus_DEM  

 Where clause: Value > 0  

 Output Raster: \SaltLake\HWM\HWMOutput\Depth_Grid  

 When subtracting the water surface from the DEM, there are places where the 
DEM is at a greater elevation than the water surface. This indicates there is no 
water depth. Removing the negative values leaves only the depth of flooding.  

 

 

 

 

 

 Click “OK.” Your map should appear as follows: 
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Task  4: Create a Flood Boundary 

 In ArcToolbox, open the Reclass toolset in the Spatial Analyst Tools.  

 Select the Reclassify tool.  
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 Set the following parameters:  

 Input Raster: Depth_Grid  

 Reclass Field: VALUE  

 Click “Load…”  

 Navigate to “\SaltLake\HWM\” and choose the “hwmreclass.info” file.  

 Set the Output Raster as “\SaltLake\HWM\HWMOutput\RECLASS.”  

 

 

 

 

 

 Click “OK.”  

 From the Conversion Toolbox, open the “From Raster” Toolset.  

 Open the “Raster to Polygon” tool and complete the parameters as shown below.  

 Input raster: RECLASS  

 Field: Value  

 Output polygon features: \SaltLake\HWM\HWMOutput\Flood_Boundary  

 Uncheck “Simplify Polygons.”  
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 Click “OK.”  

Note: You should now have a flood depth grid and flood boundary that looks 
similar to the following image depending on how you decided to symbolize the 
layers.  
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Demonstration 11.1: ShakeMap using Hazus 

Interface - Background 

Type: Instructor-Led Demonstration  

Time: 25 minutes  

Goal: Use the Hazus interface to find a ShakeMap.  

 Note: A new feature of Hazus 4.2 is the ability to add ShakeMaps via the Hazus 
Interface. The HAZUS USGS shakemap database is a combination of multiple sources 
including ATLAS, which holds 6,100 earthquakes.  

 

 Task  1: Create New Salt Lake City Study Region  

 Open Hazus 4.2.  

 Click “Create a new study region” and then “OK.”  

 The Create New Region window will appear. Click “Next.”  

 Name the study region “Salt_Lake_City_EQ” and enter a brief description such as, 
“Shakemap exercise for Salt Lake City earthquakes.” Click “Next.”  

 Check the box “Earthquake” and click “Next.”  

 Click “County” and then “Next.”  

 Select “Utah” and click “Next.”  

 Select “Salt Lake” County and click “Next.”  

 Click “Finish.”  

 

 Task  2: Open Salt Lake City Study Region  

 Click “Open a region” and then “OK.” The “Open Region” window will appear.  

 Click “Next.”  

 Select “Salt_Lake_City_EQ” and click “Next.”  

 Click “Finish.” ArcMap will open your Salt Lake City region.  

 

  Task  3: Use Hazus Interface to Define USGS ShakeMap  

Note: There is a new scenario option in Hazus 4.2 to directly analyze ShakeMaps from 
available data. We will import one of these earthquakes and evaluate losses. 

 In the top menu bar, navigate to “Hazard > Scenario…”  

 The Scenario Wizard window will appear. Click “Next.”  

 Click “Define a new scenario” and click “Next.”  

 Click “USGS ShakeMap…” and click “Next.”  

 The “ShakeMap Download” window will appear.  
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Note: This will initially show the available earthquake data for earthquakes 
between 5 and 9.5 magnitude in the rectangular extent of your study region for 
the last 90 days. By expanding the amount of days and the rectangular extent, 
you will find available archived historical events. 

 Change the following search attributes:  

 Max Latitude: 42.5  

 Min Latitude: 37.5  

 Max Longitude: -109.5  

 Min Longitude: -113.5  

 Start Time: Today Minus 90000 Days  

 

 

 

 

 

 Click “Search.” 

 One earthquake with Available Earthquake Data will be shown. 

 Select the earthquake to populate the Event Properties and ShakeMap Details 
areas. 
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 Click the "ShakeMap Scenarios" radio button in the top left of the dialog box. This 
will cause Hazus to search for all ShakeMaps of hypothetical earthquake scenarios 
that are within the search parameters. 

 

 

 

 

 

 Select the "M 7.0 Scenario Earthquake - The Great Utah ShakeOut" earthquake to 
populate the Event Properties and ShakeMap Details areas. 

 Review the data shown (EX: where you can find the date, time, source of the 
earthquake data, other information). 

 Click “Download Grid Data.” 

 This will take approximately one to two minutes. 

 After the grid data has downloaded, the Scenario Wizard window will appear with all 
defaults filled in. Click “Next.” 

 The name window will appear. Click “Next.” 

 Click “Finish.” 

 To see the hazard study region parameters, go to “Hazard > Show Current” in the 
top menu bar. 

 The Current Hazard Selection window will show the current analyzable scenario. 
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 Navigate to “Analysis > Run.”  

 This will bring up the Analysis Options window. Unselecting the options that do 
not interest you will decrease the processing time required to run an analysis.  

 Click “Select All.”  

 Select “Yes” to indicate that you do NOT want Contour Maps and click “OK.”  

 Click “Yes” to run the analysis.  

 It should take approximately four to five minutes.  

 After your analysis finishes, a window will appear with the elapsed time. Click 
“OK.”  

 

  Task  4: View Direct Economic Loss  

 Navigate to “Results > General Building Stock > Building Economic Loss > Direct 
Economic Loss.” The “Direct Economic Loss (in thousands of dollars)” window will 
now appear.  

 Select the “Total” tab and scroll all the way to the right.  

 Click the “Total Loss (thous. $)” tab. Click “Map” and then “Close.”  
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Exercise 11.2: Source Event 

Type: Student-Led Activity  

Time: 25 minutes  

Goals:  

 Create a Source Event Scenario.  

 Create a map of economic loss. 

Background: Modeling source events in Hazus is a powerful tool to use when 
developing a portfolio of losses or impacts. For example, running numerous source 
events can provide a variety of case studies or scenarios that can inform disaster 
operations managers how the terrain or soil type may correlate with ground shaking, 
where losses are most likely, or what attributes or buildings are most likely to be 
damaged (such as building type). All of this information can inform response plans, 
mitigation measures, and general risk assessments. For example, if damages to a 
specific school district are projected to be similar across different source events, that 
school district might need additional mitigation resources or attention during response 
and recovery efforts. 

 

 Task 1: Open Study Region Salt_Lake_City_EQ 

 Open Hazus 4.2.  

 Click “Open a region” and then click “OK.”  

 Click “Next.”  

 Select “Salt_Lake_City_EQ” and click “Next.”  

 Click “Finish.”  

 

  Task 2: Define the Scenario 

 In the top ribbon, navigate to “Hazard > Scenario…”  

 This will open the “Scenario Wizard” window. Click “Next.”  

 Click “Define a new scenario” and then “Next.”  

 Click “Source Event…” and then “Next.” A California Fault Disclaimer will appear. 
Click “ACCEPT.”  
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 Click the “MaxMagnitude” column and then right-click to select “Map.”  
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 The “Please Select Source Fault” window will appear.   
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 Select the small central fault by clicking and dragging your cursor. Click “Selection 
Done.”  

Note: The Scenario Wizard window will show this is the Taylorsville fault with a 
max magnitude of 6.5.  

 

 

 

 

 

 Click “Next” to define the “Source Event Parameters.”   
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 Click “Define” to choose the epicenter of the earthquake on the fault. 
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 Click the furthest westward point, as shown, and click “Selection Done.”  

Note: This will populate the Latitude and Longitude.  
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 Enter “5.0” for the Moment Magnitude to ensure the ShakeMap damage and the 
Source Event damage will be as similar as possible (even though the ShakeMap 
damage shows 4.3 magnitude damage). Click “Next.”   

 

 

 

 

 

 Name the Source Event “Salt_Lake_City_Source_5.0” and click “Next.” 
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 Click “Finish.” 

 

  Task 3: Define the Soil Map 

 Go to Hazard > Data Maps  

 This will bring up the “Data Maps Dialog” window  
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 This shows the current ShakeMap layers that are in use from the last scenario. If no 
scenarios have been input, this window would be blank.  

 Click “Add map to list…” which will bring up a file browser window.  

 Browse to the Activities folder double-click ModelBuilderShakeMap.mdb.  

 This will bring up a “Data Map Attributes” window  

 

 

 

 

 

 Type “Soil” for “Map name:” and select “NEHRP_Soil” for “Table name:” Maintain 
“Map Type” as “Soil.” 
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 Click “OK” 

 

 

 

 

 

 This added a new soil map to the study region but it did not define it for use in this 
analysis.  

 Click "Close". 

 To define the soil map, navigate to “Hazard > Scenario…”  
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 Click “Next.”  

 Click “Define hazard maps” and then “Next.”  

 

 

 

 

 

 Under “Soil map” select “Soil” from the drop-down menu. Click “Next” and then 
“Finish.”  

Note: This added a new soil map to the study region.  

 

 



March 2019 E0179: Application of Hazus for Disaster Operations 

Handouts: Reference Materials  SM-514 

 

 

 

 Navigate to “Hazard > Show Current.” 
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 You can now see the ShakeMap source event parameters that will be used.  

 Click the “Current Hazard Maps” tab and you can see that in the soil for the study 
region has now been set.  
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 Click “Soil” and then “Map.” You cannot click anywhere in the row, you must click the 
word “Soil.” Close the window and the soil variation will now appear over the region. 
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  Task 4: Run Analysis 

 Navigate to “Analysis > Run” and click “Select All.”  

 Click “No” to indicate to Hazus that you would like it to create Contour Maps.  

 Click “OK” and then “Yes” to run the analysis. After your analysis finishes, a window 
will appear with the elapsed time. Click “OK.”  

 This will take approximately 4 minutes.  

 Navigate to “Results > Ground Motion or Ground Failure > Contour or Ground 
Failure Maps.”  

 A Contour Maps window will appear.  

 Click “PGA Contour” and then “Map.”  

 Hazus will add another layer called “eqGrid_PGA” in the Table of Contents of 
ArcMap. NOTE: Now there are three PGA contour layers with the same name. 
Since the first two scenarios are no longer current, if you click to see the old data 
it will no longer appear. If you went back to the old scenario, you would have to 
map the PGA contours again for it to reappear.  

 Close the Contour Maps window.  
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 Move the “Soil type” layer to the top of the Table of Contents so it appears above the 
PGA contour map. 
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 Go to the layer properties in the Display tab and change the layer to be “30% 
transparent” and click “OK.” 
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 Zoom in to the epicenter to see how the Soil Classifications have influences that 
ground acceleration.  

Note: If the study region was all one soil class then the acceleration would be 
symmetrical around the epicenter.  
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  Task 5: View Direct Economic Loss Results 

 Navigate to “Results > General Building Stock > Building Economic Loss> Direct 
Economic Loss.”  

 Go to the “Total” tab and scroll all the way to the right.  

 Click the “Total Loss (thous. $)” tab and then “Map.” Click “Close.”  
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 You can again change the symbology properties to “Natural Breaks (Jenks)” to get a 
better depiction of losses in the area. 

 

 

 

 

 

 Navigate to “Results > Summary Reports…”  
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 Go to the “Other” tab and select the “Global Summary Report” and click “View.”  

 Navigate to page 8 by clicking the single right-pointing arrow.  
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Exercise 12.1: ShakeMap  

Type: Student-Led Activity  

Time: 25 minutes  

Goals:  

 Import a ShakeMap 

 Create a map of economic loss 

 

 Part 1: Open Study Region Salt_Lake_City_EQ 

 Open Hazus 4.2 

 Click "Open a region.” Click “OK.” 

 Click “Next.” 

 Select “Salt_Lake_City_EQ.” Click “Next.” 

 Click “Finish.” 

 

Part 2: Define the Scenario 

 Navigate to “Hazard > Scenario…” 

 Click “Next.” 

 Click “Define a new scenario.” Click “Next.” 

 Click “USGS ShakeMap” and Click “Next.” 

 The “ShakeMap Download” dialog box will appear. 

 Click the “ShakeMap Scenarios” radio button in the top left of the dialog box in order 
to search for scenario instead of event ShakeMaps. 

 Select the “M 7.1 Scenario Earthquake – Wasatch Flt SLC Pechmann” earthquake. 
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 Click “Download Selected ShakeMap Grid Data.” 

 This will take approximately one to two minutes. 

 After the grid data has downloaded, the Scenario Wizard window will appear with all 
defaults filled in. Click “Next.” 

 The name window will appear. Click “Next.” 

 Click “Finish.” 

 

Part 3: Run Analysis 

 Navigate to “Analysis > Run.” 

 Click “Select all.” 

 Click “Yes” to indicate to Hazus that you would like it to skip Contour Maps. 

 Click “OK” and then “Yes” to run the analysis. After your analysis finishes, a window 
will appear with the elapsed time. Click “OK.” 

 This will take approximately 4 to 5 minutes. 
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Part 4: View Direct Economic Loss Results 

 Navigate to “Results > General Building Stock > Building Economic Loss> Direct 
Economic Loss.” 

 Go to the “Total” tab and scroll all the way to the right. 

 Click the “Total Loss (thous. $)” tab and then “Map.” Click “Close.” 

 This map is still not very descriptive of the damage because of its symbology. 

 

 

 

 

 

 Right click on the Layer and go to "Properties." 

 Click the “Symbology” tab.  

 Click “Classify” in the Classification area. 
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 Click the drop-down menu for the “Method:” and select “Natural Breaks (Jenks).” 
Click “OK.” 

 Click “OK” in the Layer Properties window.  

Note: That is a much more descriptive map and shows the power of Hazus and 
ArcMap together. 
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Exercise 13.1: ShakeMap with UDF  

Type: Student-Led Activity  

Time: 45 minutes  

Goals:  

 Run a ShakeMap Analysis with UDF Results.  

 Create a map of economic loss.  

Background: User-defined facilities data can be used to enhance the quality of loss 
estimation and improve the results of Hazus. Including UDF data in your analysis also 
allows you to customize the scenarios to your unique community and its needs. UDF 
data may include essential facilities like schools or hospitals, but it can also include 
details on residences or structures of interest to a community, such as a church or 
community center.   

 

  Task 1: Create a New Study Region for Salt Lake City  

 Open Hazus 4.2.  

 Click “Create a new study region” and then click “OK.” Note that these steps are very 
similar to those utilized in creating other regions.  

 The “Create New Region” window will appear. Click “Next.”  

 Name the study region “Salt_Lake_City_UDF.”  

 Write a brief description such as “XML ShakeMap exercise for Salt Lake City 
earthquakes with UDF.” Click “Next.”  

 Check the box “Earthquake” and click “Next.”  

 Click “County” and then click “Next.”  

 Select “Utah” and then click “Next.”  

 Select “Salt Lake” county and then click “Next.”  

 Click “Finish.”    

 

  Task 2: Open the Salt Lake City Study Region 

 Click “Open a region” and then click “OK.” The “Open Region” window will appear.  

 Click “Next.”  

 Select “Salt_Lake_City_UDF” and then click “Next.”  

 Click “Finish.” ArcMap will open your Salt Lake City region.  
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  Task 3: Add a ShakeMap 

Note: In this task, the user will import a new XML file.  

 Navigate to “Hazard > Scenario…” and then click “Next.”  

 Click “Define a new scenario” and then click “Next.”  

 Click “USGS ShakeMap…” and then click “Next.”  

 Click the “ShakeMap Scenarios” radio button in the top left to switch the ShakeMap 
search from events to scenarios. 

 Select the earthquake scenario entitled “M 7.0 Scenario Earthquake – The Great 
Utah ShakeOut.” 

 Click the “Download Selected ShakeMap Grid Data” Button. This may take several 
moments. 

 Click “Next” and you’ll see Hazus has named the scenario for you. Click “Next” and 
then click “Finish.” 

 

  Task 4: Run the Earthquake Analysis  

 Navigate to “Analysis > Run.”  

 Click “Select All.”  

 Click “Yes” to indicate to Hazus that you would like it to skip Contour Maps.  

 Click “OK” and then “Yes” to run the analysis. After your analysis finishes, a window 
will appear with the elapsed time. Click “OK.” This will take approximately 2 minutes.  
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  Task 5: View Direct Economic Loss Results  

 Go to “Results > General Building Stock > Building Economic Loss > Direct 
Economic Loss.”  

 Go to the “Total” tab and scroll all the way to the right.  

 Click the “Total Loss (thous. $)” tab and then “Map.” Click “Close.”  

 

 You can again change the symbology properties to “Natural Breaks (Jenks)” to get a 
better depiction of losses in the area. 

 

 Go to “Results > User-Defined Facilities.”  

 Scroll to the right and select the “At Least Moderate” column header.  

 

 Click “Map” and then “Close.” 
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Exercise 14.1: Tsunami Study Region 

Type: Student-Led Activity  

Time: 15 minutes  

Goal: Build a Tsunami Study Region  

 Background: This document describes how to build the student region for a Tsunami 
Level 1 analysis in Tillamook, Oregon. This analysis will use sample hazard data from 
FEMA that may be downloaded from the FEMA hazard website. Expand the Download 
section, click to confirm you are not a robot. Scroll down past the state geodatabases 
and click “here” at the bottom, right above the “State Managed Download” button to 
download the Tsunami data. This data has been downloaded for you and is in the 
HazardSampleData.gdb.  

 

Task 1: Build a Tsunami Study Region 

 Download and extract the FEMA sample data to the C:\HazusData folder.  

 Start the Hazus application.  

 Select the “Create a new region” option in the startup dialog and click “OK.” Then 
click "Next". 
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 Name the region “Tillamook_OR,” enter a description (such as “Case study for 
Tsunami scenario”), and click “Next.”  

 Check only the “Tsunami” box in the list of hazards and click “Next.” This is because 
we are going to analyze a distant-source tsunami (not a near-source/combined 
earthquake and tsunami).  

 

 

 

 

 

 In the Aggregation Level dialog, select “County” from the choices and click “Next.”   
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 In the State selection dialog, select “Oregon” and click “Next.” 
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 In the County Selection dialog, select “Tillamook” and click “Next.”  

Note: In the case of modeling a tsunami occurring on a state border, multiple 
counties can be selected from multiple states.  
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 You have now successfully selected all the required options to create the new 
region. Click “Finish” on the dialog.  

Note: At this point, if you do not already have the Oregon data downloaded, you 
will be prompted to:  

 Copy the state data into C:\HazusData\Inventory.  

 Visit the Hazus portal page at https://msc.fema.gov/portal/resources/hazus 

 Select “Oregon” for Direct Download.  

 Extract the data into the C:\HazusData\Inventory\OR folder.  

 After extraction, click “Retry” to aggregate data into the selected region.  

 If the Oregon data already existed in the C:\HazusData\Inventory folder, Hazus 
will proceed to the next steps without a prompt to copy the state data.  

 

Task 2: Open the Region and Input Tsunami User Data  

 Upon successful region aggregation, a confirmation will appear.  

 Click “OK” then select “Open a region” to start the analysis using the Open Region 
Wizard. Click “OK.”  
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 Select the “Tillamook_OR” region and click “Next” in the Select Region dialog. 
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 You have now completed the steps to open the region and start an analysis. Click 
“Finish” to open the region.  

 The ArcMap window should show the case study area in Tillamook County, Oregon.  
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 Start the tsunami hazard analysis by selecting the “Hazard” menu, then “Tsunami 
Hazard Type.”  

 Choose “Distant Source” in the Tsunami Hazard Type window. Then click "OK". 

 Return to the Tsunami Hazard Type drop-down menu and select “User Data.” This 
will open the User Data Wizard.  

 Choose “Level 1: Runup Only-Mean Sea Level (MSL)” and click “Next.”  
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 To specify the runup height grid and DEM from our downloaded sample data that 
has been extracted into the C:\HazusData\MSC_HazardSampleData folder:  

 Click “Browse Height” and navigate to the runup grid, then click "Select": 
C:\HazusData\MSC_HazardSampleData\Garibaldi\Level1.gdb\gar_maxR_ft.  

 Click “Browse DEM” and navigate to the DEM, then click "Select": 
C:\HazusData\MSC_HazardSampleData\Garibaldi\Level1.gdb\gar_dem_ft.  

 Make sure that height units are in “feet” and DEM vertical units are in “feet.”  

 Click “OK” to process the data and create two layers: Median Momentum Flux 
and Median Inundation Depth.  

 Click “Next.”  

Note: In this example, the DEM data has been provided for you. However, you 
can download a DEM directly from Hazus by clicking “Determine required DEM 
extent.” Hazus then determines the required DEM extent based on the study 
region and automatically downloads and extracts the necessary layers.  
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 Name the scenario “Garibaldi_20ft_Scenario.” Click “Next.”  

 Click “OK” to complete the User Data Wizard.  

 The next exercise will build upon this exercise. If exiting ArcMap, please click 
“Save.”  
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Exercise 15.1: Tsunami Analysis 

Type: Student-Led Activity  

Time: 30 minutes  

Goal: Run a Tsunami and Casualty Level 1 Analysis  

 Background: This exercise describes how to run a Tsunami Level 1 analysis for the 
study region that was created in Exercise 14.1 in Tillamook, Oregon. A casualty 
analysis will be run after the Tsunami damages are modeled. The options and 
requirements for tsunami analysis in Hazus are unique compared to the other hazards. 
It is important to remember that as a disaster operations manager or responder, the 
quality of the tsunami model results is directly correlated to the quality of the input data. 
This exercise follows sample data to see how the datasets are utilized, but the case 
study data may not represent the true analysis options available for your region or data 
supplied. 

 

Task 1: Specific Tsunami Analysis Options and Run Analysis  

 Make sure the Tillamook, OR study region is open. If it is not open, open the region 
in Hazus. 

 On the Analysis drop-down menu, select “Run” and then “OK” on the Combined 
Analysis notice. The notice refers to the combined Earthquake and Tsunami 
Analysis for Near Source events. This combined analysis will be run in the next 
lesson. See Chapter 11 of the Tsunami User Manual for more information. 

 In the “Analysis Options > Tsunami” menu, select all options in the inventory view 
and click “OK.” Updating the tsunami direct damages and economic values will take 
a few moments.  
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 When the Analysis is complete, a window will appear showing the elapsed time to 
run the analysis. Click “OK.” This will take roughly 5 minutes.  

 To calculate Level 1 Casualty estimates after the Tsunami General Building Stock 
(GBS) Analysis is complete, choose “Casualty” on the Analysis drop-down menu.  

 On the Casualty submenu, choose “TIGER Roadway Network” to download the road 
data.  

 Note: If a download error occurs, the TIGER road network can be obtained from 
the TIGER data website based on County Federal Information Processing 
Standards [FIPS]) https://www2.census.gov/geo/tiger/TIGER2016/ROADS/ 

 Note: For reference, county FIPS codes are available for download as a 
spreadsheet from the U.S. Census Bureau.  https://www2.census.gov/programs-
surveys/popest/geographies/2016/all-geocodes-v2016.xlsx 

 The model will save the road network data to the 
C:\HazusData\HazardInput\TS\TIGER\ folder under the County FIPS code for the 
study region.  

 

 

http://www2.census.gov/geo/tiger/TIGER2016/ROADS/
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 When the TIGER road network has been downloaded, you will receive a notification 
of where the files are located. Make a note of the file location and click “OK” to 
proceed with the casualty analysis.  

 From the Analysis drop-down menu, choose “Casualty > Casualty Level 1.”  

 In the Casualty Level 1 Wizard, click each of the four buttons (DEM Data, Roadway 
Network, Hazard Boundary, and Fatality Boundary), and browse to the 
corresponding files as follows:  

 DEM Data: 
C:\HazusData\MSC_HazardSampleData\Garibaldi\Level1.gdb\gar_dem_ft  

 Roadway Network: 
C:\HazusData\HazardInput\TS\TIGER\Roads\tl_2016_41057_roads  

 Hazard Boundary: C:\HazusData\Regions\Tillamook_OR\tsHazardBoundary.shp  

 Fatality Boundary: C:\HazusData\Regions\Tillamook_OR\tsFatalityBoundary.shp  

Note: The Hazard Boundary and Fatality Boundary were created by the model. 
The Hazard Boundary is the inundation hazard boundary (depth > 0), and the 
Fatality Boundary is the portion of the inundation hazard where the flood depths 
are expected to be 2 meters or greater in depth (Fatality Rate = 99%).  

 Once the input data is selected, enter the Casualty Time Parameters in the boxes 
below.  

Note: The model will enter default values once there is a value for Arrival Time 
(10 minutes in this exercise).  

 The user should review these and modify as needed.  

 Warning time cannot exceed arrival time; if values are entered that are 
inconsistent with this, Hazus will prompt the user to change them.  

 In addition, for a near source event where the ground shaking provides the 
trigger for warning, a warning time value of 0 minutes may be entered.  

 Click “Next.”  

 

Task 2: Run Casualty Analysis  

 From the Analysis drop-down menu, choose “Casualty > Casualty Level 1.”  
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 In the Casualty Level 1 Wizard, click each of the four buttons (DEM Data, Roadway 
Network, Hazard Boundary, and Fatality Boundary), and browse to the 
corresponding files as follows:  

 DEM Data: 
C:\HazusData\MSC_HazardSampleData\Garibaldi\Level1.gdb\gar_dem_ft  

 Roadway Network: 
C:\HazusData\HazardInput\TS\TIGER\Roads\tl_2016_41057_roads  

 Hazard Boundary: C:\HazusData\Regions\Tillamook_OR\tsHazardBoundary.shp  

 Fatality Boundary: C:\HazusData\Regions\Tillamook_OR\tsFatalityBoundary.shp  

Note: The Hazard Boundary and Fatality Boundary were created by the model. 
The Hazard Boundary is the inundation hazard boundary (depth > 0), and the 
Fatality Boundary is the portion of the inundation hazard where the flood depths 
are expected to be 2 meters or greater in depth (Fatality Rate = 99%).  

 Once the input data is selected, enter the Casualty Time Parameters in the boxes 
below.  

Note: The model will enter default values once there is a value for Arrival Time 
(10 minutes in this exercise).  

 The user should review these and modify as needed.  

 Warning time cannot exceed arrival time; if values are entered that are 
inconsistent with this, Hazus will prompt the user to change them.  

 In addition, for a near source event where the ground shaking provides the 
trigger for warning, a warning time value of 0 minutes may be entered.  

 Click “Next.”  
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 For the next few steps, the user will accept the program defaults. The model is 
projecting the data into the same projected coordinate system. Click “Next.” 
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 The model then preprocesses the DEM, Roads and Hazard Boundaries.  

 The default output cell size is 10 meters.  

 The Speed Conservation Value (SCV) default is 1, which assumes that road 
networks have no reduction in the capability to support evacuation. A SCV of less 
than 1.0 reduces the capability of the road network to support evacuation.  
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 Click “Next.”  

 The model calculates the Evacuation Time required at the selected Travel Speed. 
The default speed is Average Walk. The Maximum Travel Time in Minutes, by 
default, is blank. Click “Next.”  
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 Next, the model computes travel time and the probability of casualties. Click “Next.” 
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 This completes the Casualty Level 1 Estimate. Click “OK.”  

 The results and reports are accessible under the Results drop-down menu and 
are very similar to viewing results and reports of other disasters modeled in 
Hazus.  

 To view casualty analysis results, select “Results > Casualties > Probability of 
Casualties” to view a table and map features.  

 The Good, Fair, and Poor categories indicate the study region’s level of 
preparedness.  

 To view casualty analysis reports, select “Results > Summary Reports.”  

 Click on the “Losses” tab and select the “Casualties-All” report. Click “View” to open 
the report.  
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Exercise 16.1: Combined Earthquake and 

Tsunami Exercise 

Type: Student-Led Activity  

Time: 60 minutes  

Goal: Run a Combined Near Source Earthquake and Tsunami Analysis.  

 Background: This exercise utilizes a ShakeMap from a U.S. Geological Survey 
(USGS) Cascadia earthquake scenario to simulate a magnitude 9.0 earthquake and a 
resulting tsunami for damage results in Tillamook County, Oregon.  

 

Task 1: Download the state database to create and open a study 
region 

 If the Oregon state dataset has already been downloaded and appears in your 
HazusData\Inventory folder, skip to creating a new region. Otherwise, continue with 
the next step. 

 Go to the Federal Emergency Management Agency’s (FEMA) Flood Map Service 
Center (MSC) website https://msc.fema.gov/portal/resources/hazus.  

 Download and extract the “Oregon State Database” to 
“C:\HazusData\Inventory\OR.”  

 Open Hazus 4.2.  

 Click “Create a new region” and then “OK.”  

 The Create New Region window will appear. Click “Next.”  

 Name the Study Region “Tillamook_EQ_TS” and add the description 
“Earthquake+Tsunami event in Tillamook County.”  
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 Click “Next.” 

 Check the boxes for “Earthquake” and “Tsunami” and click “Next.”  

 Select “County” and click “Next.”  

 Select “Oregon (OR)” and click “Next.”  

 Select “Tillamook” and click “Next.”  

 Click “Finish.”  

 A window will appear once the region has been successfully aggregated. Click “OK.”  

 Select “Open a region” and click “OK.”  

 Click “Next.”  

 Select “Tillamook_EQ_TS” and click “Next.”  

 Click “Earthquake.” You must define the near source earthquake before evaluating 
the Tsunami. Click “Next.” 

 Click “Finish.” An ArcMap document with Tillamook County, OR will appear. 
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Optional Task 2: View user defined facilities in Tillamook County, 
Oregon 

This task will be completed if there is sufficient time in class. Otherwise, students are 
encouraged to complete these steps on their own to review the UDF data for a 
combined earthquake and tsunami analysis.   

 Navigate to “Inventory > User Defined Facilities,” located in the top ribbon. 

 Scroll to the right to see more information about these facilities.  
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 Click the “YearBuilt” column header and click “Map.” NOTE: Build year is frequently 
related to the types of seismic and tsunami codes used when the building was 
constructed. Maintaining accurate UDF data is crucial to producing accurate and 
reliable results that rely on building data.  

 

Task 2: Download Cascadia near source earthquake ShakeMap 

 Navigate to the USGS M9.0 Scenario Earthquake – Cascadia 9.0 Scenario webpage 
https://earthquake.usgs.gov/scenarios/eventpage/uscasc9.0_expanded_peak_se#sh
akemap?source=us&code=uscasc9.0_expanded_peak_se.  

 Scroll down and expand the “Downloads” section.  

 Underneath “XML Grids” (the first download option), click to download the “ZIP 
(7.5MB)” file. Click “Save.”  

 Click “Open Folder.”  

 “Grid.xml.zip” will appear in your downloads folder.  

 Right-click the zipped file and select “Extract All…” An extraction window will appear. 
Click “Extract.”  

https://earthquake.usgs.gov/scenarios/eventpage/uscasc9.0_expanded_peak_se#shakemap?source=us&code=uscasc9.0_expanded_peak_se
https://earthquake.usgs.gov/scenarios/eventpage/uscasc9.0_expanded_peak_se#shakemap?source=us&code=uscasc9.0_expanded_peak_se
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 A grid.xml folder will be created. Move the folder into your study region folder in 
C:\HazusData\Regions\Tiillamook_EQ_TS. If the download did not work, this file can 
be found in the Activities data folder.  

  

 

Task 3: Open ShakeMap in Hazus and run an analysis 

 In Hazus, go to Hazard > Scenario…,” located in the top ribbon.  

 The “Scenario Wizard” window will appear. Click “Next.” 

 Click “Define a new scenario” and then “Next.”  

 Click “USGS ShakeMap” and click “Next.”  

 

 

 

 

 

 A “ShakeMap Download” window will appear. Click “Browse grid.xml” at the bottom 
right on the new window.  

 Browse to “C:\HazusData\Regions\Tillamook_EQ_TS\grid.xml\.” Select “grid” and 
click “Open.”  

 Hazus will then process the grid.xml. It will take approximately 1 minute. A new 
window will appear for other hazard parameters. Accept the pre-populated values 
and click “Next.” 
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 Click “Next” again to name the event if it is not populated already.  

 Click “Finish” in the “Scenario Wizard” window.  

 

 

 

 

 

 Navigate to “Analysis > Run.”  

 An Analysis Options window will appear. Unselecting the options that do not interest 
you will decrease the processing time required to run an analysis. Click “Select All.”  

 Click “Yes” to indicate that you do want to skip Contour Maps. Then click “OK.” 

 Click “Yes” to run the analysis. It should take less than 5 minutes.  

 After your analysis finishes, a window will appear with the elapsed time. Click “OK.”  

 

Task 4: Explore earthquake results 

 Navigate to “Results > User-Defined Facilities.” 

 Scroll to see the damages sustained. Click on the “At Least Moderate” column 
header and “Map.” Then click "Close". 

 Navigate to “Results > Summary Reports…”  

 Select the “Other” tab and then “Global Summary Report.” Click “View.”  

 Go to page 8 by clicking the single arrow pointed right.  
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Task 5: Run a tsunami analysis 

 Click the "Switch Hazard" button on the far left underneath "File". 
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 The “Select Hazard” window will appear. Select “Tsunami” and click “OK.” It may 
take a minute for ArcMap to close and open the study region to the Tsunami Hazard. 

 A blank ArcMap of the study region will open.  

 Navigate to “Hazard > Tsunami Hazard Type…”  

 This will open the “Tsunami Hazard Type” window. Click “Near Source only” and 
click “OK.”  

 

 

 

 

 

 Navigate to “Hazard > User Data.” 

 The “User Data” window will appear. Click “Level 1: Runup Only-Mean Sea Level 
(MSL)” and then “Next.” 

 Select the Height Units as “ft” and the DEM Vertical Units as “ft.”  

 Click “Browse Height.” The same process will be done that was done for Exercises 
14.1 and 15.1. 

 Browse to the Activities folder and navigate to 
MSC_HazardSampleData/Garibaldi/Level1.gbd/. Choose “gar_maxR_ft” as the 
runup height grid. Click “Select.”  

 The file will be added to the “Select dataset(s).” 

 Click “Browse DEM.” 

 Browse to the Activities folder and navigate to 
/MSC_HazardSampleData/Garibaldi/Level1.gbd/. Select “gar_dem_ft” as the DEM 
grid. Click “Select.”  

 The file will be added to the “Select dataset(s).” Click “OK.” 

 The max run-up and a deformed DEM (post-earthquake) will appear on in the study 
region. Click “Next.”  
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 Enter the name “Cascadia_9.0_EQ_TS” and click “Next.” A depth polygon will be 
created in your table of contents. 

 Click “OK” to complete the User Data Wizard. 

 

Task 6: Run the combined analysis 

 Navigate to “Analysis > Run…”  

 Click “Select All” to select all analysis options and then “OK.”  

 It should take approximately 3 to 4 minutes. After your analysis finishes, a window 
will appear with the elapsed time. Click “OK.”  

 

Task 7: Download the roadways and run a level 1 casualty 
analysis 

 Navigate to “Analysis > Casualty > Download TIGER Roadway Network.”  

 Take note of where the roadways were downloaded and unzipped. Click “OK.”  

 Navigate to “Analysis > Casualty > Level 1.”  

 The Casualty Level 1 window will appear.  
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 Click “DEM Data.”  

 Browse to /MSC_HazardSampleData/Garibaldi/Level1.gbd/. Choose “gar_dem_ft” 
and click “Select.” 

 Click “Roadway Network” and browse to the location noted earlier with the TIGER 
roadway. Navigate to 
C:\HazusData\HazusInput\TS\TIGER\Roads\tl_2016_41057_roads and select the 
shapefile. 

 Click “Hazard Boundary.” Browse to C:/HazusData/Regions/Tillamook_EQ_TS/ and 
select “tsHazardBoundary.shp.” Click “Select.” 

 Click “Fatality Boundary.” Browse to C:/HazusData/Regions/Tillamook_EQ_TS/ and 
select “tsFatalityBoundary.shp.” Click “Select.” 

 Enter an arrival time of “10” minutes. The other fields will automatically populate to 
15 for Time to Maximum Runup and 10 for Warning Time. Click “Next.” 

 Click “Next” on the “Process Level 1 Casualty Input” screen. 

 Click “Next.” The cell size fields will automatically populate. If they do not, enter the 
following: 

 In CellSize X: 52.4 

 In CellSizeY: 52.4 

 Out CellSize: 10   

 Click “Next” in the Evacuation Time Copulations window for Average Walk of 1.22 
meter/second.  
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 Click “Next” in the Compute Travel Time and Probability of Causalities window. No 
boxes should be checked.  

 Click “OK” to complete the Casualty Level 1 Wizard. 

 

Task 8: Explore tsunami and combined analysis results 

 Navigate to “Results” > “General Building Stock” > “Direct Economic Loss.”  

 Select the “Total” tab and scroll to the right.  

 Click the “Total Loss(thous. $)” column header and click “Map.” Then click "Close". 

 Zoom in to the tsunami study area.  

  

 

 

 

 

 

 Right-click on the total losses layer in the Table of Contents and go to "Properties." 
Click the “Symbology” tab. 
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 In the "Quantities" menu on the left, select "Graduate colors".  

 Under Classification, select “Classify.” This will open the Classification menu. 

 In the drop down menu under "Method" select "Natural Breaks (Jenks)" and click 
"OK". 

  

 

 

 

 

 

 Click “OK” in the “Layer Properties” window to close it.  

 The map is now better classified for this data. Observe the changes in colors on the 
map. 

 To explore Combined Losses Results, navigate to “Results” > “Combined User 
Defined Facilities” > “Combined Building Damage State.” 

 Scroll to the right. Click the “PDsExcExtStruct” column and click “Map.” 

 In the Table of Contents, turn off the UDF Damage State and the Tsunami Total 
Loss Layers by unchecking them. Only the Exceeded Structure Damages for User 
Defined Facilities layer should be visible. 

 Navigate to “Results” > “Casualties” > “Probability of Casualties.” 
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 In the “DayGood” tab, select the “FatalityDayTotal” column header. Click “Map.” 
Then click "Close". 

 View the fatality results on the map. 

 Navigate to “Results > Summary Reports…” 

 Select the “Other” tab and click “Combined Earthquake and Tsunami Global Risk 
Report” and then “View.” 

 Explore the Report document. 
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Exercise 17.1 - Packaging Data 

 Type: Instructor-Led Activity  

 Time: 10 minutes  

 Goals:  

 Export User Defined Facilities (UDF) shapefile.  

 Export HAZUS HPR file.  

 

 Task 1: Open a Study Region 

 Open Hazus 4.2.  

 Click “Open a region” and then click “OK.”  

 Click “Next.”  

 Select “Salt_Lake_City_UDF” and click “Next.” Use the region created in Activity 
13.1 (ShakeMap with UDF).  

 Click “Finish.”  

 

 Task 2: Export the UDF Data 

 Right-click on the “UDF layer” in the Table of Contents. Navigate to “Data > Export 
Data.” 
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 Click the folder icon and browse to the destination folder. Name the shapefile 
“UDF_export.shp.” 
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 Click “No” when asked if you want to add the exported data to the map as a layer (it 
would be repeated).  

 

 Task 3: Export Hazus HPR 

 Close the Hazus Study region and open Hazus 4.2.  

 Click “Export/Backup a region” and click “OK.”  

 Select “Salt_Lake_City_UDF.”  
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 Click “Browse.”  

 Browse to the destination folder. Name the HPR file “SLC_UDF.hpr” and click 
“Save.”  

 Click “Export/Backup.”  

 Hazus will indicate the region export was successful. Click “OK.” Then click “Close.” 

Note: Now the user can send the HPR file to another user and maintain their 
data and layers. Results will have to be selected or re-run to be seen in some 
cases. 
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Exercise 17.3 - GIS Online 

 Type: Instructor-Led Activity  

Time: 20 minutes  

 Goal: Explore GIS online options for creating maps and communicating information.  

 

Task 1: Access ArcGIS Online 

 Go to the ArcGIS Online website https://www.arcgis.com 

 You can sign in or create an account if desired, but it is not necessary for this 
activity.  If you signed in, skip to the next part of this activity. If not, continue here.  

 Click “Map” at the top of the page, then “Modify Map.” 

 

Task 2: Load Data of Choice 

 From the user dashboard, click “Content” to begin creating an online map.  

 Click Create and from the drop down select Map.  

 Enter a title, tags, and select the folder to save the map to.  

 To upload a new dataset, choose “Add,” and then “Add Layer from File.” 

 

 

 

 

 

 You may choose any of the data layers used during this course to upload.  

 ArcGIS Online accepts multiple file types, including Shapefiles, comma-
separated values, Excel spreadsheets, and zip files. Shapefiles must be imported 
as a single compressed zip file.  

 Once the file has been located, click “Import Layer” and the file will upload to a new 
map. 
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Task 3: View Online Map 

 In the left-side table of contents move your mouse over the name of the uploaded 
data file.  

 Click on the diagram of the circle, square, and triangle to change the style of the 
map.  

 

 

 

 

 

 Make some styling changes to familiarize yourself with the options.  

 After you have made alterations and select “Share.”  

 Your map is now published to your account and the ArcGIS Online community.  

 You also have a direct link to your map to share and you can create a web app 
including this map. 

 

Task 4: View geoplatform.gov 

 Navigate to geoplatform.gov  

 Scroll through the website to familiarize yourself with the Apps & Services and 
Featured Applications this resource offers.  

 

Task 5: View Carto Online 

 Navigate to https://carto.com  

 Scroll and click through the website to see options of online maps and other 
resources available. This is just another example of online platforms available for 
GIS development and communication. 

 

https://carto.com/
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Activity 17.4: Static Maps 

Type: Instructor-Led Activity 

 Time: 10 minutes  

Goal: Create a static map from the results of one of the activities you completed in this 
course.  

 

Task 1: Open Region and Scenario of Your Choice.  

 Choose an exercise from this course to use as the source for your map. 

 Export the study region you used in the exercise (such as Tillamook_EQ_TS) as an 
hpr. 

 Make a copy of the hpr you wish to use and re-label the file with a .zip extension. 
Click yes if prompted to confirm the change. 

 Unzip the folder and find the map document. 

 Open the map document in ArcMap. 

  

 

Task 2: Define Resolution (default: 300dpi) and Output Image 
Quality 

 Zoom in and out, change colors, or select layers to be viewed in the map document.  

 At the bottom of the map window, toggle between the “Data” View and the “Layout” 
view.  

 The “Layout” View is used to design and author a map for printing, exporting, or 
publishing. You can manage map elements within the page space (typically, in 
inches or centimeters), add new map elements, and preview what the map will 
look like before exporting or printing it.  

 Common map elements include data frames with map layers, scale bars, north 
arrows, symbol legends, map titles, text, and other graphic elements. The 
“Layout” Toolbar allows you to move around the page layout without changing 
the data. The data can be moved within the data frame.  

 As you develop your map, keep in mind what information you are trying to 
communicate. Who is the audience? What is the purpose? What is your message? 
Is this map going to be read by emergency responders? Is this map for a local 
government when discussing economic recovery?  

 Add a title, a legend, a scale bar, and a north arrow.  

 Export the map as a PDF to see an example of a final product.  
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